Portable Projector

VT700

User’s Manual

The projector's model name indicated on the projector's label is VT700 and VT700G respectively. All two models are referred to as VT700 throughout the user’s manual except some of the specifications pages.
• IBM is a trademark or registered trademark of International Business Machines Corporation.
• Macintosh, Mac OS X and PowerBook are trademarks of Apple Inc. registered in the U.S. and other countries.
• Microsoft, Windows and PowerPoint are trademarks or registered trademarks of Microsoft Corporation.
• VESA is a registered trademark of Video Electronics Standards Association.
• Other product and company names mentioned in this user’s manual may be the trademarks or registered trademarks of their respective holders.

NOTES
(1) The contents of this user’s manual may not be reprinted in part or whole without permission.
(2) The contents of this user’s manual are subject to change without notice.
(3) Great care has been taken in the preparation of this user’s manual; however, should you notice any questionable points, errors or omissions, please contact us.
(4) Notwithstanding article (3), NEC will not be responsible for any claims on loss of profit or other matters deemed to result from using the Projector.
Important Information

Safety Cautions

Precautions
Please read this manual carefully before using your NEC VT700 projector and keep the manual handy for future reference. Your serial number is located on the bottom of your projector. Record it here:

**CAUTION**
To turn off main power, be sure to remove the plug from power outlet.
The power outlet socket should be installed as near to the equipment as possible, and should be easily accessible.

**CAUTION**
TO PREVENT SHOCK, DO NOT OPEN THE CABINET.
THERE ARE HIGH-VOLTAGE COMPONENTS INSIDE.
REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

This symbol warns the user that uninsulated voltage within the unit may be sufficient to cause electrical shock. Therefore, it is dangerous to make any kind of contact with any part inside of the unit.

This symbol alerts the user that important information concerning the operation and maintenance of this unit has been provided.
The information should be read carefully to avoid problems.

**WARNING:** TO PREVENT FIRE OR SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE.
DO NOT USE THIS UNIT'S PLUG WITH AN EXTENSION CORD OR IN AN OUTLET UNLESS ALL THE PRONGS CAN BE FULLY INSERTED.

DOC Compliance Notice (for Canada only)
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Machine Noise Information Regulation - 3. GPSGV,
The highest sound pressure level is less than 70 dB (A) in accordance with EN ISO 7779.

**CAUTION**
Avoid displaying stationary images for a prolonged period of time.
Doing so can result in these images being temporarily sustained on the surface of the LCD panel.
If this should happen, continue to use your projector. The static background from previous images will disappear.

Disposing of your used product
EU-wide legislation as implemented in each Member State requires that used electrical and electronic products carrying the mark (left) must be disposed of separately from normal household waste. This includes projectors and their electrical accessories or lamps. When you dispose of such products, please follow the guidance of your local authority and/or ask the shop where you purchased the product.
After collecting the used products, they are reused and recycled in a proper way. This effort will help us reduce the wastes as well as the negative impact such as mercury contained in a lamp to the human health and the environment at the minimum level.
The mark on the electrical and electronic products only applies to the current European Union Member States.
WARNING TO CALIFORNIA RESIDENTS:
Handling the cables supplied with this product will expose you to lead, a chemical known to the State of California to cause birth defects or other reproductive harm. WASH HANDS AFTER HANDLING.

RF Interference (for USA only)

**WARNING**
The Federal Communications Commission does not allow any modifications or changes to the unit EXCEPT those specified by NEC Display Solutions of America, Inc. in this manual. Failure to comply with this government regulation could void your right to operate this equipment. This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio / TV technician for help.

For UK only: In UK, a BS approved power cable with moulded plug has a Black (five Amps) fuse installed for use with this equipment. If a power cable is not supplied with this equipment please contact your supplier.

**Important Safeguards**
These safety instructions are to ensure the long life of your projector and to prevent fire and shock. Please read them carefully and heed all warnings.

**Installation**
• Do not place the projector in the following conditions:
  - on an unstable cart, stand, or table.
  - near water, baths, or damp rooms.
  - in direct sunlight, near heaters, or heat radiating appliances.
  - in a dusty, smoky or steamy environment.
  - on a sheet of paper or cloth, rugs or carpets.

• If you wish to have the projector installed on the ceiling:
  - Do not attempt to install the projector yourself.
  - The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk of bodily injury.
  - In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance with any local building codes.
  - Please consult your dealer for more information.
Place the projector in a horizontal position

The tilt angle of the projector should not exceed 10 degrees, nor should the projector be installed in any way other than the desktop and ceiling mount, otherwise lamp life could decrease dramatically.

=max(10,5)

Fire and Shock Precautions

- Ensure that there is sufficient ventilation and that vents are unobstructed to prevent the build-up of heat inside your projector. Allow at least 4 inches (10cm) of space between your projector and a wall.
- Do not try to touch the ventilation outlet on the left front (when seen from the front) as it can become heated while the projector is turned on and immediately after the projector is turned off.
- Prevent foreign objects such as paper clips and bits of paper from falling into your projector. Do not attempt to retrieve any objects that might fall into your projector. Do not insert any metal objects such as a wire or screwdriver into your projector. If something should fall into your projector, disconnect it immediately and have the object removed by a qualified service personnel.
- Do not place any objects on top of the projector.
- Do not touch the power plug during a thunderstorm. Doing so can cause electrical shock or fire.
- The projector is designed to operate on a power supply of 100-240V AC 50/60 Hz. Ensure that your power supply fits this requirement before attempting to use your projector.
- Do not look into the lens while the projector is on. Serious damage to your eyes could result.
- Keep any items such as magnifying glass out of the light path of the projector. The light being projected from the lens is extensive, therefore any kind of abnormal objects that can redirect light coming out of the lens, can cause unpredictable outcome such as fire or injury to the eyes.
- Do not cover the lens with the black lens cap or equivalent while the projector is on. Doing so can lead to melting of the cap and possibly burning your hands due to the heat emitted from the light output.
- Do not place any objects, which are easily affected by heat, in front of the projector lens or a projector exhaust vent. Doing so could lead to the object melting or getting your hands burned from the heat that is emitted from the light output and exhaust.
- Handle the power cable carefully. A damaged or frayed power cable can cause electric shock or fire.
  - Do not use any power cables than the supplied one.
  - Do not bend or tug the power cable excessively.
  - Do not place the power cable under the projector, or any heavy object.
  - Do not cover the power cable with other soft materials such as rugs.
  - Do not heat the power cable.
  - Do not handle the power plug with wet hands.
- Turn off the projector, unplug the power cable and have the projector serviced by a qualified service personnel under the following conditions:
  - When the power cable or plug is damaged or frayed.
  - If liquid has been spilled into the projector, or if it has been exposed to rain or water.
  - If the projector does not operate normally when you follow the instructions described in this user’s manual.
  - If the projector has been dropped or the cabinet has been damaged.
  - If the projector exhibits a distinct change in performance, indicating a need for service.
- Disconnect the power cable and any other cables before carrying the projector.
- Turn off the projector and unplug the power cable before cleaning the cabinet or replacing the lamp.
- Turn off the projector and unplug the power cable if the projector is not to be used for an extended period of time.
CAUTION
• Do not use the tilt-foot for purposes other than originally intended. Misuses such as gripping the tilt-foot or hanging on the wall can cause damage to the projector.
• Do not send the projector in the soft case by parcel delivery service or cargo shipment. The projector inside the soft case could be damaged.
• When carrying the projector by the carrying handle, make sure the two screws that attach the carrying handle to the projector cabinet are tight.
  Insufficient tightening of the two screws could result in the projector falling and causing injury.
• Select [High] in Fan mode if you continue to use the projector for consecutive days. (From the menu, select [Setup] → [Options] → [Fan Mode] → [High].)
• Do not turn off the AC power by pressing the main power switch or by unplugging the power cable when the projector is powered on.
• Do not turn off the AC power for 60 seconds after the lamp is turned on and while the POWER indicator is blinking green. Doing so could cause premature lamp failure.

Remote Control Precautions
• Handle the remote control carefully.
• If the remote control gets wet, wipe it dry immediately.
• Avoid excessive heat and humidity.
• Do not heat, take apart, or throw batteries into fire.
• If you will not be using the remote control for a long time, remove the batteries.
• Ensure that you have the batteries' polarity (+/-) aligned correctly.
• Do not use new and old batteries together, or use different types of batteries together.
• Dispose of used batteries according to your local regulations.

Lamp Replacement
• To replace the lamp, follow all instructions provided on page 50.
• Be sure to replace the lamp when the message [The lamp has reached the end of its usable life. Please replace the lamp.] appears. If you continue to use the lamp after the lamp has reached the end of its usable life, the lamp bulb may shatter, and pieces of glass may be scattered in the lamp case. Do not touch them as the pieces of glass may cause injury.
  If this happens, contact your dealer for lamp replacement.

A Lamp Characteristic
The projector has a high-pressure mercury lamp as a light source.
A lamp has a characteristic that its brightness gradually decreases with age. Also repeatedly turning the lamp on and off will increase the possibility of its lower brightness.

CAUTION:
When removing the lamp from a ceiling-mounted projector, make sure that no one is under the projector. Glass fragments could fall if the lamp has been burned out.

About High Altitude mode
• Set [Fan Mode] to [High Altitude] when using the projector at altitudes approximately 5500 feet/1600 meters or higher. Using the projector at altitudes approximately 5500 feet/1600 meters or higher without setting to [High Altitude] can cause the projector to overheat and the protector could shut down. If this happens, wait a couple minutes and turn on the projector.
• Using the projector at altitudes less than approximately 5500 feet/1600 meters and setting to [High Altitude] can cause the lamp to overcool, causing the image to flicker. Switch [Fan Mode] to [Auto].
• Using the projector at altitudes approximately 5500 feet/1600 meters or higher can shorten the life of optical components such as the lamp.
# Table of Contents

## Important Information

1. Introduction
   1. What’s in the Box?  
   2. Introduction to the Projector  
   3. Part Names of the Projector  
      - Attaching the supplied carrying handle  
      - Top Features  
      - Terminal Panel Features
   4. Part Names of the Remote Control  
      - Battery Installation  
      - Remote Control Precautions  
      - Operating Range for Wireless Remote Control

2. Installation and Connections
   1. Setting Up the Screen and the Projector  
      - Selecting a Location  
      - Throw Distance and Screen Size
   2. Making Connections  
      - Enabling the computer’s external display  
      - Connecting Your PC or Macintosh Computer  
      - When Viewing a DVI Digital Signal  
      - Using Two Analog COMPUTER Inputs Simultaneously  
      - Connecting an External Monitor  
      - Connecting Your DVD Player with Component Output  
      - Connecting Your VCR or Laser Disc Player  
      - Connecting the Supplied Power Cable

3. Projecting an Image (Basic Operation)
   1. Turning on the Projector  
      - Note on Startup screen (Menu Language Select screen)
   2. Selecting a Source  
   3. Adjusting the Picture Size and Position  
   4. Correcting Keystone Distortion  
   5. Optimizing RGB Picture Automatically  
   6. Turning Up or Down Volume  
   7. Turning off the Projector  
   8. After Use
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4. Convenient Features</td>
<td>28</td>
</tr>
<tr>
<td>1. Turning off the Image and Sound</td>
<td>28</td>
</tr>
<tr>
<td>2. Freezing a Picture</td>
<td>28</td>
</tr>
<tr>
<td>3. Enlarging a Picture</td>
<td>28</td>
</tr>
<tr>
<td>4. Changing Lamp Mode</td>
<td>29</td>
</tr>
<tr>
<td>5. Preventing the Unauthorized Use of the Projector</td>
<td>29</td>
</tr>
<tr>
<td>6. Using the Optional Remote Mouse Receiver (NP01MR)</td>
<td>32</td>
</tr>
<tr>
<td>5. Using On-Screen Menu</td>
<td>34</td>
</tr>
<tr>
<td>1. Using the Menus</td>
<td>34</td>
</tr>
<tr>
<td>2. Menu Elements</td>
<td>36</td>
</tr>
<tr>
<td>3. List of Menu Items</td>
<td>37</td>
</tr>
<tr>
<td>4. Menu Descriptions &amp; Functions [Picture]</td>
<td>39</td>
</tr>
<tr>
<td>5. Menu Descriptions &amp; Functions [Image Options]</td>
<td>40</td>
</tr>
<tr>
<td>6. Menu Descriptions &amp; Functions [Setup]</td>
<td>42</td>
</tr>
<tr>
<td>7. Menu Descriptions &amp; Functions [Information]</td>
<td>46</td>
</tr>
<tr>
<td>8. Menu Descriptions &amp; Functions [Reset]</td>
<td>47</td>
</tr>
<tr>
<td>6. Maintenance</td>
<td>48</td>
</tr>
<tr>
<td>1. Cleaning or Replacing the Filters</td>
<td>48</td>
</tr>
<tr>
<td>2. Cleaning the Cabinet and the Lens</td>
<td>49</td>
</tr>
<tr>
<td>3. Replacing the Lamp</td>
<td>50</td>
</tr>
<tr>
<td>7. Appendix</td>
<td>53</td>
</tr>
<tr>
<td>1. Troubleshooting</td>
<td>53</td>
</tr>
<tr>
<td>2. Specifications</td>
<td>56</td>
</tr>
<tr>
<td>3. Cabinet Dimensions</td>
<td>58</td>
</tr>
<tr>
<td>4. Pin Assignments of D-Sub COMPUTER Input Connector</td>
<td>59</td>
</tr>
<tr>
<td>5. Compatible Input Signal List</td>
<td>60</td>
</tr>
<tr>
<td>6. PC Control Codes and Cable Connection</td>
<td>61</td>
</tr>
<tr>
<td>7. Troubleshooting Check List</td>
<td>62</td>
</tr>
<tr>
<td>8. TravelCare Guide</td>
<td>64</td>
</tr>
</tbody>
</table>
1. Introduction

What's in the Box?

Make sure your box contains everything listed. If any pieces are missing, contact your dealer. Please save the original box and packing materials if you ever need to ship your projector.

Projector

Lens cap (24FT9641)

Soft case (24BS7582)

Power cable (US: 7N080220)
(EU: 7N080015)

VGA signal cable (7N520052)

Remote control (7N900731)

Batteries (AAA × 2)

Quick Setup Guide
Important Information

CD-ROM
User’s manual

For North America only
Registration card
Limited warranty

For Europe only
Guarantee policy

Carrying handle (24FT9651)
Screw (M4 × 2: 24V00411)

DVI to VGA adapter (7N960232)
1. Introduction

Introduction to the Projector

This section introduces you to your new projector and describes the features and controls.

Congratulations on Your Purchase of the Projector

This projector is one of the very best projectors available today. The projector enables you to project precise images up to 300 inches across (measured diagonally) from your PC or Macintosh computer (desktop or notebook), VCR, DVD player, document camera, or a laser disc player.

You can use the projector on a tabletop or cart, you can use the projector to project images from behind the screen, and the projector can be permanently mounted on a ceiling*1. The remote control can be used wirelessly.

*1 Do not attempt to mount the projector on a ceiling yourself.

The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk of bodily injury.

In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance with any local building codes. Please consult your dealer for more information.

Features you'll enjoy:

• Auto vertical keystone correction up to +/- 30 degrees
• Built-in Wall Color Correction presets provide for adaptive color correction when projecting onto non-white screen material
• Quick start & quick cool down
  Eight seconds after turning on the power, the projector is ready to display PC or video images.
  Powering down; The fans stop 30 seconds after turning off the power from the remote control or cabinet control panel. The projector can be put away immediately after the projector is powered down.
  Also, the main power of the projector can be turned off by pressing the main power switch or unplugging the power cable even during the cool down period after the projector is turned off.
• DVI input connector (DVI-I 29 Pin) with HDCP compatible
• HDTV (1080i, 720p) and SDTV (576p, 480p) compatibility
• Color Management system
• Short focal length lens
• Display popular wide screen and full screen aspect ratios – 16:9 and 4:3
• Built-in speaker for an integrated audio solution
• High resolution display - up to UXGA compatible, XGA native resolution
• Multiple video mode selections (depending on your source)
• Security feature prevents unauthorized individuals from displaying images.
• You can control the projector with a PC or control system using the PC Control port.
• Easy set up and operation
• The contemporary cabinet design is light, compact and complements any office, boardroom Auditorium.
• You can use the supplied wireless remote control and the optional remote mouse receiver to operate your PC mouse from across the room. The optional remote mouse receiver (NP01MR) supports almost any PC using a USB connection.

About this user's manual

The fastest way to get started is to take your time and do everything right the first time. Take a few minutes now to review the user's manual. This may save you time later on. At the beginning of each section of the manual you'll find an overview. If the section doesn't apply, you can skip it.
### Part Names of the Projector

**Front/Top**

- Zoom Lever (→ page 22)
- Controls (→ page 5)
- Remote sensor (→ page 8)
- Focus Ring (→ page 22)
- Lens
- Lens Cap
- Ventilation (inlet) / Filter Cover (→ page 48)
- Built-in Security Slot ( khóa ) *

* This security slot supports the MicroSaver ® Security System. MicroSaver ® is a registered trademark of Kensington Microware Inc. The logo is trademarked and owned by Kensington Microware Inc.

**Rear**

- Terminal Panel (→ page 6)
- Remote sensor (→ page 8)
- Monaural Speaker (5W)
- AC Input
  - Connect the supplied power cable's two-pin plug here, and plug the other end into an active wall outlet. (→ page 17)
  - Main Power Switch
    - When you plug the supplied power cable into an active wall outlet and turn on the Main Power, the POWER indicator turns orange and the projector is in standby mode. (→ page 18,26)
- Ventilation (outlet)
  - Heated air is exhausted from here.
Attaching the supplied carrying handle

You can carry the projector by attaching the supplied carrying handle securely to the projector. To attach the supplied carrying handle, use a Phillips-head screwdriver and the supplied two screws. Place a soft cloth on the working surface before turning the projector over to prevent scratching the top cover. Make sure that the carrying handle is attached with correct orientation as shown below.

CAUTION

When carrying the projector by the carrying handle, make sure the two screws that attach the carrying handle to the projector cabinet are tight.
1. Introduction

Top Features

1. LAMP Indicator (→ page 50, 53)
2. STATUS Indicator (→ page 53)
3. POWER Indicator (→ page 18, 26, 53)
4. POWER Button (ON / STAND BY) (●) (→ page 18, 26)
5. SOURCE Button (→ page 20)
6. AUTO ADJ. Button (→ page 25)
7. MENU Button (→ page 34)
8. SELECT ▲▼◄► / Volume Buttons ◄► / Keystone Buttons ▲▼ (→ page 23, 25)
9. ENTER Button
10. EXIT Button
Terminal Panel Features

1. COMPUTER 1 IN/ Component Input Connector (Mini D-Sub 15 Pin) (→page 11,13)
2. AUDIO IN Mini Jack (Stereo Mini) (→page 11,12,15)
3. AUDIO OUT Mini Jack (Stereo Mini) (→page 14)
4. MONITOR OUT Connector (Mini D-Sub 15 Pin) (→page 14)
5. S-VIDEO IN Connector (Mini DIN 4 Pin) (→page 16)
6. VIDEO IN Connector (RCA) (→page 16)
7. AUDIO Input Jacks L/R (RCA) (→page 15,16)
8. PC CONTROL [PC CTRL] Port (DIN 8 Pin) (→page 61)
   Use this port to connect a PC or control system. This enables you to control the projector using serial communication protocol. If you are writing your own program, typical PC control codes are on page 61.
9. COMPUTER 2 (DVI-I) IN (DVI-I 29 Pin) (→page 12,13)
1. Infrared Transmitter  
(→ page 8)

2. POWER ON Button  
(→ page 18)

3. POWER OFF Button  
(→ page 26)

4. MAGNIFY (+)(–) Button  
(→ page 28)

5. PIC-MUTE Button  
(→ page 28)

6. PAGE UP/DOWN Button*  
(→ page 32,33)

7. MENU Button  
(→ page 34)

8. SELECT ▲▼◄► Button

9. ENTER Button

10. EXIT Button

11. MOUSE L-CLICK Button*  
(→ page 32,33)

12. MOUSE R-CLICK Button*  
(→ page 32,33)

13. VIDEO Button  
(→ page 20)

14. S-VIDEO Button  
(→ page 20)

15. COMPUTER 1/2 Button  
(→ page 20)

16. AUTO ADJ. Button  
(→ page 25)

17. VOLUME (+)(–) Button  
(→ page 25)

18. LAMP MODE Button  
(→ page 29)

19. ASPECT Button  
(→ page 40)

20. PICTURE Button  
(→ page 39,40)

21. HELP Button  
(→ page 46,47)

22. FREEZE Button  
(→ page 28)

* The PAGE UP/DOWN, MOUSE L-CLICK and MOUSE R-CLICK buttons work only when the optional remote mouse receiver is connected with your computer.
1. Introduction

Battery Installation

1. Press firmly and slide the battery cover off.
2. Install new batteries (AAA). Ensure that you have the batteries' polarity (+/-) aligned correctly.
3. Slip the cover back over the batteries until it snaps into place. Do not mix different types of batteries or new and old batteries.

Remote Control Precautions

- Handle the remote control carefully.
- If the remote control gets wet, wipe it dry immediately.
- Avoid excessive heat and humidity.
- Do not heat, take apart, or throw batteries into fire.
- If you will not be using the remote control for a long time, remove the batteries.
- Ensure that you have the batteries' polarity (+/-) aligned correctly.
- Do not use new and old batteries together, or use different types of batteries together.
- Dispose of used batteries according to your local regulations.

Remote Control Precautions

Operating Range for Wireless Remote Control

- The infrared signal operates by line-of-sight up to a distance of about 22 feet/7 m and within a 60-degree angle of the remote sensor on the projector cabinet.
- The projector will not respond if there are objects between the remote control and the sensor, or if strong light falls on the sensor. Weak batteries will also prevent the remote control from properly operating the projector.
This section describes how to set up your projector and how to connect video and audio sources. Your projector is simple to set up and use. But before you get started, you must first:

1. Set up a screen and the projector.
2. Connect your computer or video equipment to the projector.  
   (→ page 11,12,13,14,15,16)
3. Connect the supplied power cable.  
   (→ page 17)

**NOTE:** Ensure that the power cable and any other cables are disconnected before moving the projector. When moving the projector or when it is not in use, cover the lens with the lens cap.

### Setting Up the Screen and the Projector

#### Selecting a Location

The further your projector is from the screen or wall, the larger the image. The minimum size the image can be is approximately 21" (0.53 m) measured diagonally when the projector is roughly 38 inches (1.0 m) from the wall or screen. The largest the image can be is 300" (7.6 m) when the projector is about 389 inches (9.9 m) from the wall or screen.

**TIP:**
- The distances are indicated by intermediate values between tele and wide. Use as a rule of thumb.
- The Zoom lever adjusts the image size +/-10%
- For more details on throw distance, see page 10.

---

To the wall outlet.
### Throw Distance and Screen Size

The following shows the proper relative positions of the projector and screen. Refer to the table to determine the position of installation.

#### Distance Chart

![Diagram](image)

- **B** = Vertical distance between lens center and screen center
- **C** = Throw distance
- **D** = Vertical distance between lens center and screen bottom (top of screen for ceiling application)
- **α** = Throw angle

**NOTE:** Distances may vary +/-5%.

<table>
<thead>
<tr>
<th>Screen Size</th>
<th>Diagonal Width (mm)</th>
<th>Diagonal Height (mm)</th>
<th>B wide (mm)</th>
<th>B tele (mm)</th>
<th>C wide (mm)</th>
<th>C tele (mm)</th>
<th>D wide (mm)</th>
<th>D tele (mm)</th>
<th>α width (degree)</th>
<th>α tele (degree)</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>533</td>
<td>17</td>
<td>427</td>
<td>13</td>
<td>320</td>
<td>4</td>
<td>110</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>25</td>
<td>635</td>
<td>20</td>
<td>508</td>
<td>15</td>
<td>381</td>
<td>5</td>
<td>130</td>
<td>28</td>
<td>720</td>
<td>-</td>
</tr>
<tr>
<td>30</td>
<td>762</td>
<td>24</td>
<td>610</td>
<td>18</td>
<td>457</td>
<td>6</td>
<td>160</td>
<td>34</td>
<td>870</td>
<td>-</td>
</tr>
<tr>
<td>40</td>
<td>1016</td>
<td>32</td>
<td>813</td>
<td>24</td>
<td>610</td>
<td>8</td>
<td>210</td>
<td>46</td>
<td>1170</td>
<td>-</td>
</tr>
<tr>
<td>60</td>
<td>1524</td>
<td>48</td>
<td>1219</td>
<td>36</td>
<td>914</td>
<td>12</td>
<td>310</td>
<td>70</td>
<td>1770</td>
<td>84</td>
</tr>
<tr>
<td>72</td>
<td>1829</td>
<td>58</td>
<td>1463</td>
<td>43</td>
<td>1097</td>
<td>15</td>
<td>380</td>
<td>84</td>
<td>2130</td>
<td>101</td>
</tr>
<tr>
<td>80</td>
<td>2032</td>
<td>64</td>
<td>1626</td>
<td>48</td>
<td>1219</td>
<td>17</td>
<td>420</td>
<td>93</td>
<td>2370</td>
<td>112</td>
</tr>
<tr>
<td>84</td>
<td>2134</td>
<td>67</td>
<td>1707</td>
<td>50</td>
<td>1280</td>
<td>17</td>
<td>440</td>
<td>98</td>
<td>2490</td>
<td>115</td>
</tr>
<tr>
<td>90</td>
<td>2286</td>
<td>72</td>
<td>1829</td>
<td>54</td>
<td>1372</td>
<td>19</td>
<td>470</td>
<td>105</td>
<td>2670</td>
<td>126</td>
</tr>
<tr>
<td>100</td>
<td>2540</td>
<td>80</td>
<td>2032</td>
<td>60</td>
<td>1524</td>
<td>21</td>
<td>520</td>
<td>117</td>
<td>2970</td>
<td>141</td>
</tr>
<tr>
<td>120</td>
<td>3048</td>
<td>96</td>
<td>2438</td>
<td>72</td>
<td>1829</td>
<td>25</td>
<td>630</td>
<td>141</td>
<td>3570</td>
<td>169</td>
</tr>
<tr>
<td>150</td>
<td>3810</td>
<td>120</td>
<td>3048</td>
<td>90</td>
<td>2286</td>
<td>31</td>
<td>790</td>
<td>176</td>
<td>4470</td>
<td>211</td>
</tr>
<tr>
<td>180</td>
<td>4572</td>
<td>144</td>
<td>3658</td>
<td>108</td>
<td>2743</td>
<td>37</td>
<td>940</td>
<td>211</td>
<td>5370</td>
<td>254</td>
</tr>
<tr>
<td>200</td>
<td>5080</td>
<td>160</td>
<td>4064</td>
<td>120</td>
<td>3048</td>
<td>41</td>
<td>1050</td>
<td>235</td>
<td>5870</td>
<td>282</td>
</tr>
<tr>
<td>210</td>
<td>5334</td>
<td>168</td>
<td>4267</td>
<td>128</td>
<td>3200</td>
<td>43</td>
<td>1100</td>
<td>247</td>
<td>6270</td>
<td>296</td>
</tr>
<tr>
<td>240</td>
<td>6096</td>
<td>192</td>
<td>4877</td>
<td>144</td>
<td>3658</td>
<td>50</td>
<td>1260</td>
<td>282</td>
<td>7170</td>
<td>339</td>
</tr>
<tr>
<td>270</td>
<td>6858</td>
<td>216</td>
<td>5486</td>
<td>162</td>
<td>4115</td>
<td>56</td>
<td>1410</td>
<td>318</td>
<td>8070</td>
<td>381</td>
</tr>
<tr>
<td>300</td>
<td>7620</td>
<td>240</td>
<td>6096</td>
<td>180</td>
<td>4572</td>
<td>62</td>
<td>1570</td>
<td>353</td>
<td>8970</td>
<td>424</td>
</tr>
</tbody>
</table>

### WARNING

- Installing your projector on the ceiling must be done by a qualified technician. Contact your NEC dealer for more information.
- Do not attempt to install the projector yourself.
- Only use your projector on a solid, level surface. If the projector falls to the ground, you can be injured and the projector severely damaged.
- Do not use the projector where temperatures vary greatly. The projector must be used at temperatures between 41°F (5°C) and 104°F (40°C) (Eco mode selected automatically at 95°F to 104°F/35°C to 40°C).
- Do not expose the projector to moisture, dust, or smoke. This will harm the screen image.
- Ensure that you have adequate ventilation around your projector so heat can dissipate. Do not cover the vents on the side or front of the projector.

### Reflecting the Image

Using a mirror to reflect your projector’s image enables you to enjoy a much larger image when a smaller space is required. Contact your NEC dealer if you need a mirror system. If you’re using a mirror system and your image is inverted, use the MENU and SELECT buttons on your projector cabinet or your remote control to correct the orientation. (→ page 43)
2. Installation and Connections

Making Connections

NOTE: When using with a notebook PC, be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on the power to the notebook PC.
In most cases the output signal from the notebook PC is not turned on unless connected to the projector before being powered up.
* If the screen goes blank while using your remote control, it may be the result of the computer’s screen-saver or power management software.

Enabling the computer's external display

Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projector. When using a PC compatible laptop, a combination of function keys will enable/disable the external display. Usually, the combination of the “Fn” key along with one of the 12 function keys gets the external display to come on or off. For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through external display selections.

Connecting Your PC or Macintosh Computer

NOTE: The COMPUTER 1 connector supports Plug & Play (DDC2).

Connecting Your PC or Macintosh Computer

Audio cable (not supplied)
VGA signal cable (supplied)
To mini D-Sub 15-pin connector on the projector. It is recommended that you use a commercially available distribution amplifier if connecting a signal cable longer than the cable supplied.

NOTE: For older Macintosh, use a commercially available pin adapter (not supplied) to connect to your Mac’s video port.

NOTE: The projector is not compatible with video decoded outputs of the NEC ISS-6020 switcher.

NOTE: An image may not be displayed correctly when a Video or S-Video source is played back via a commercially available scan converter.
This is because the projector will process a video signal as a computer signal at the default setting. In that case, do the following.
* When an image is displayed with the lower and upper black portion of the screen or a dark image is not displayed correctly:
  Project an image to fill the screen and then press the AUTO ADJ. button on the remote control or the projector cabinet.
When Viewing a DVI Digital Signal

To project a DVI digital signal, be sure to connect the PC and the projector using a DVI cable (not supplied) before turning on your PC or projector. Turn on the projector first and select Computer 2 (Digital) from the source menu before turning on your PC.

Failure to do so may not activate the digital output of the graphics card resulting in no picture being displayed. Should this happen, restart your PC.

Do not disconnect the DVI cable while the projector is running. If the signal cable has been disconnected and then re-connected, an image may not be correctly displayed. Should this happen, restart your PC.

NOTE:

- Use a DVI cable or the one compliant with DDWG (Digital Display Working Group) DVI (Digital Visual Interface) revision 1.0 standard. The DVI cable should be within 5 m (196") long. Both single and dual types of DVI cable can be used.
- The DVI (DIGITAL) connector accepts VGA (640x480), SVGA (800x600), 1152x864, XGA (1024x768) and SXGA (1280x1024 @ up to 60Hz).
Using Two Analog COMPUTER Inputs Simultaneously

If you need to use two analog COMPUTER inputs simultaneously, connect a VGA signal cable as shown below.

NOTE: When the DVI to VGA adapter is not to be used for an extended period of time, remove it from the projector. Failure to do so may cause damage to the connector of the projector.
2. Installation and Connections

Connecting an External Monitor

You can connect a separate, external monitor to your projector to simultaneously view on a monitor the RGB analog image you're projecting.

NOTE:
- Daisy chain connection is not possible.
- The signal from the COMPUTER 2 IN connector cannot be output from the MONITOR OUT connector.
- When the DVI Digital signal is selected, no signals will be output from the MONITOR OUT connector.
Connecting Your DVD Player with Component Output

A component signal will be automatically displayed. If not, from the menu, select [Setup] → [Options] → [Signal Select] → [Computer 1], and then place a check mark in the Component radio button.

**NOTE:** Refer to your DVD player’s owner’s manual for more information about your DVD player’s video output requirements.
Connecting Your VCR or Laser Disc Player

NOTE: The AUDIO IN L/MONO and R jacks (RCA) are shared between the Video and S-Video inputs.

NOTE: Refer to your VCR or laser disc player owner’s manual for more information about your equipment’s video output requirements.

NOTE: An image may not be displayed correctly when a Video or S-Video source is played back in fast-forward or fast-rewind via a scan converter.
Connecting the Supplied Power Cable
Connect the supplied power cable to the projector. First connect the supplied power cable’s two-pin plug to the AC IN of the projector, and then connect the other plug of the supplied power cable in the wall outlet.

**CAUTION:**
Do not try to touch the ventilation outlet on the left front (when seen from the front) as it can become heated while the projector is turned on and immediately after the projector is turned off.

**CAUTION:**
Do not turn off the AC power by pressing the main power switch or by unplugging the power cable when the projector is powered on. Doing so can cause damage to the projector.

**TIP:** The projector can be turned off (by either the main power switch or by unplugging the power cable) during its cool down period after it is turned off using the remote control or via the power button on the control panel.

Make sure that the prongs are fully inserted into both the AC IN and the wall outlet.
This section describes how to turn on the projector and to project a picture onto the screen.

1. **Turning on the Projector**

   **NOTE:**
   - The projector has two power switches: a main power switch and a POWER (ON/STAND BY) button (POWER ON and OFF on the remote control).
   - When plugging in or unplugging the supplied power cable, make sure that the main power switch is pushed to the off (⊙) position. Failure to do so may cause damage to the projector.

1. **To turn on the main power to the projector, press the Main Power switch to the on position (I).**
   
   The POWER indicator will light orange.
   
   See the Power Indicator section. (→ page 53)

2. **Remove the lens cap**

3. **Press the POWER (ON/STAND BY) button on the projector cabinet or the POWER ON button on the remote control for 1 second.**

   The POWER indicator will turn to green and the projector will become ready to use.

   After you turn on your projector, ensure that the computer or video source is turned on and that your lens cap is removed.

   **NOTE:** When no signal is available, a blue screen is displayed at the factory default. When the projector displays a blue, black, or logo screen, the projector will automatically switch to the Eco mode. The projector will return to the Normal mode once a signal is connected.

   **NOTE:** If you turn on the projector immediately after the lamp is turned off or when the temperature is high, the fans run without displaying an image for some time and then the projector will display the image.

   **CAUTION:**

   The projector cannot be turned off for 60 seconds after the lamp is turned on and while the POWER indicator is blinking green. Doing so could cause premature lamp failure.
3. Projecting an Image (Basic Operation)

Note on Startup screen (Menu Language Select screen)
When you first turn on the projector, you will get the Startup menu. This menu gives you the opportunity to select one of the 8 menu languages.

To select a menu language, follow these steps:

1. Use the SELECT ▲ or ▼ button to select one of the 8 languages from the menu.

<table>
<thead>
<tr>
<th>Menu Language Select</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Please select a menu language.</td>
<td></td>
</tr>
<tr>
<td>Wählen Sie bitte die Menü Sprache aus.</td>
<td>Deutsch</td>
</tr>
<tr>
<td>S’il vous plaît choisir la langue de menu.</td>
<td>Français</td>
</tr>
<tr>
<td>Per favore di scegliere la lingua di menu.</td>
<td>Italiano</td>
</tr>
<tr>
<td>Escoja por favor el idioma de menú.</td>
<td>Español</td>
</tr>
<tr>
<td>Välj menyn språken.</td>
<td>Svenska</td>
</tr>
<tr>
<td>メニュー言語を選択してください。</td>
<td>日本語</td>
</tr>
<tr>
<td>清選擇菜单语言。</td>
<td>中文</td>
</tr>
</tbody>
</table>

Select “UP”, ”DOWN” & ”ENTER”

2. Press the ENTER button to execute the selection.

After this has been done, you can proceed to the menu operation.
If you want, you can select the menu language later. (→ [Language] on page 37 and 42)

NOTE: Immediately after turning on the projector, screen flicker may occur. This is normal. Wait 3 to 5 minutes until the lamp lighting is stabilized.

When the Lamp mode is set to Eco, the LAMP indicator will light green.

If one of the following things happens, the projector will not turn on.
- If the internal temperature of the projector is too high, the projector detects abnormal high temperature. In this condition the projector will not turn on to protect the internal system. If this happens, wait for the projector's internal components to cool down.
- When the lamp reaches its end of usable life, the projector will not turn on. If this happens, replace the lamp.
- If the lamp fails to light, and if the STATUS indicator flashes on and off in a cycle of six times, wait a full minute and then turn on the power.


SELECTING A SOURCE

3. Projecting an Image (Basic Operation)

2 Selecting a Source

Selecting the computer or video source

**NOTE:** Turn on the computer or video source equipment connected to the projector.

Selecting from Source List

Press and quickly release the SOURCE button on the projector cabinet to display the Source list. Each time the SOURCE button is pressed, the input source will change as follows: “Computer 1”, “Computer 2 (Digital / Analog)”, “Video” (VCR or laser disc player), “S-Video”, To display the selected source, allow 1 second to elapse.

Detecting the Signal Automatically

Press and hold the SOURCE button for a minimum of 2 seconds, the projector will search for the next available input source. Each time you press and hold the SOURCE button for a minimum of 2 seconds, the input source will change as follows:

Computer1 → Computer2 (Digital) → Computer2 (Analog) → Video → S-Video → Computer1 → ...

**TIP:**
If no input signal is present, the input will be skipped.

Using the Remote Control

Press any one of the COMPUTER 1/2, VIDEO, S-VIDEO buttons.

**TIP:** The COMPUTER 2 button on the remote control toggles the Computer 2 source between [Computer 2 (Digital)] and [Computer 2 (Analog)].

Selecting Default Source

You can set a source as the default source so that it will be displayed each time the projector is turned on.

1. Select [Setup] → [Options] → [Default Source Select] from the menu.
   The [Default Source Select] screen will be displayed.

2. Select a source as the default source, and press the ENTER button.

3. Press the EXIT button a few times to close the menu.

4. Restart the projector.
   The source you selected in step 2 will be projected.
   (→ page 45)
3. Projecting an Image (Basic Operation)

### Adjusting the Picture Size and Position

Place your projector on a flat level surface and ensure that the projector is square to the screen.

Lift the front edge of the projector to center the image vertically.

* If the projected image does not appear square to the screen then use the Keystone feature for proper adjustment. (→ page 23)

Move the projector left to center the image horizontally on the screen.

---

**Adjust the Tilt Foot**

1. **Lift the front edge of the projector.**

   ![](image)

   **CAUTION:**
   Do not try to touch the ventilation outlet during Tilt Foot adjustment as it can become heated while the projector is turned on and during its cool down period after it is turned off.

2. **Push and hold the Adjustable Tilt Foot Button on the front of the projector to extend the adjustable tilt foot.**

3. **Lower the front of the projector to the desired height.**

4. **Release the Adjustable Tilt Foot Button to lock the Adjustable tilt foot.**

   There is approximately 10 degrees (up) of adjustment for the front of the projector.  
   The rear foot height can be adjusted up to 0.4 inch/10 mm.  
   Rotate the rear foot to the desired height in order to square the image on the projection surface, but the vertical distance from the bottom to the desk or floor should be 0.4 inch /10mm to make the projector horizontal on the flat surface.

   **NOTE:** Rotating the rear foot too much may cause the foot to come out of the projector.

   ![](image)

   **CAUTION:**
   - Do not use the tilt-foot for purposes other than originally intended.  
   Misuses such as using the tilt foot to carry or hang (from the wall or ceiling) the projector can cause damage to the projector.
3. Projecting an Image (Basic Operation)

**Zoom**
Use the ZOOM lever to adjust the image size on the screen.

![Zoom Image](image1)

**Focus**
Use the FOCUS ring to obtain the best focus.

![Focus Image](image2)
Correcting Keystone Distortion

If the screen is tilted vertically, keystone distortion becomes large. Proceed with the following steps to correct keystone distortion:

1. Press the SELECT \(\uparrow\) or \(\downarrow\) button with no menus displayed.
   - The keystone bar will be displayed.

2. Use the SELECT \(\uparrow\) or \(\downarrow\) to correct the keystone distortion.
   - The keystone bar will be closed after a period of time.

NOTE: When the menu is displayed, the above operation is not available. When the menu is displayed, press the MENU button to close the menu and start the Keystone correction. From the menu, select [Setup] → [General] → [Keystone]. The changes can be saved with [Keystone Save]. (→page 42)

Adjusting with the Remote Control

1. Press the MENU button.
   - The menu will be displayed.
2. Press the SELECT \(\downarrow\) button to select [Setup] and press the ENTER button.
3. Press the SELECT \(\downarrow\) button to select [Keystone].
4. Press the SELECT \(\uparrow\) or \(\downarrow\) button.
   - Adjust so that the image is rectangular.

5. Press the MENU button.
   - The menu will be closed.

NOTE: The Keystone correction can cause an image to be slightly blurred because the correction is made electronically.

TIP: The changes can be saved with [Keystone Save]. (→page 42)
3. Projecting an Image (Basic Operation)

Adjusting with the Auto Keystone Function
The Auto Keystone correction feature will correct the vertical distortion of a projected image on the screen. No special operation required. Just put the projector on a flat surface.

TIP: Even when the menu setting for [Auto Keystone] is turned on, [Keystone] can be adjusted manually.

To turn on [Auto Keystone], proceed the following steps.

1. **Press the MENU button**
   The menu will be displayed.

2. **Press the SELECT button to select [Setup] and press the ENTER button.**
   The [General] tab will be highlighted.

3. **Press the SELECT button.**
   The [Auto Keystone] will be highlighted.

4. **Press the SELECT or button to select [On].**

5. **Press the MENU button.**
   The menu will be closed.

**NOTE:**
- Vertical distortions between offset angles of +/- 30 degrees can be corrected.
- The Auto Keystone correction will take effect in 2 seconds after changing the projection angle during projection.
- The left and right (horizontal) keystone correction is not available.

Place the projector so that the lens surface is parallel to the screen. The rear feet of the projector can be adjusted to level the projector.

**NOTE:**
- Auto and Manual Keystone correction angle could be less than 30 degrees depending on the signal and/or aspect ratios.
- Using keystone correction can cause the image to be slightly blurred because the correction is made electronically.

**NOTE:**
- When the menu is displayed, the Keystone Correction operation is not available by using the buttons on the projector cabinet. When the menu is displayed, press the EXIT button to close the menu and then perform the Keystone correction.
- From the menu, select [Setup] → [General] → [Keystone]. The changes can be saved with [Keystone Save]. (→page 42)

**TIP:** If you have one of the following conditions, the projector’s Auto Keystone may not be performed correctly.
- The screen is tilted
- The room temperature is too high or too low
- The optical zoom is maximized or minimized
5 Optimizing RGB Picture Automatically

Adjusting the Image Using Auto Adjust

Optimizing an RGB image automatically.
Press the AUTO ADJ. button to optimize an RGB image automatically.
This adjustment may be necessary when you connect your computer for the first time.

[Poor picture]

[Normal picture]

NOTE:
Some signals may take time to display or may not be displayed correctly.
• The Auto Adjust function does not work for component, video, and DVI digital signals.
• If the Auto Adjust operation cannot optimize the RGB signal, try to adjust Horizontal/Vertical Position, Clock and Phase manually. (→ page 41)

6 Turning Up or Down Volume

Sound level from the speaker can be adjusted.

TIP: When no menus appear, the SELECT ◄ and ► buttons on the projector cabinet work as a volume control.
7 Turning off the Projector

To turn off the projector:

1. First, press the POWER (ON/STAND BY) button on the projector cabinet or the POWER OFF button on the remote control. The [Power Off / Are you sure?] message will appear.

2. Secondly, press the ENTER button or press the POWER (ON/STAND BY) or the POWER OFF button again.
   The power indicator will glow orange. After the projector turns off, the cooling fans keep operating for 30 seconds (Cool-down time).
   Immediately after turning on the projector and displaying an image, you cannot turn off the projector for 60 seconds.

3. Finally, turn off the Main Power switch. The power indicator will go out.

   TIP: The main power of the projector can be turned off by pressing the main power switch or by unplugging the power cable even during the cool down period after the projector is turned off.

   NOTE: Do not turn off the main power within 10 seconds of making adjustment or setting changes and closing the menu. Doing so can cause loss of adjustments and settings.

   CAUTION:
   Parts of the projector will become heated during operation. Use caution when picking up the projector immediately after it has been operating.

   CAUTION:
   • The projector cannot be turned off for 60 seconds after the lamp is turned on and while the POWER indicator is blinking green. Doing so could cause premature lamp failure.
   • Do not turn off the AC power by pressing the main power switch or by unplugging the power cable when the projector is powered on. Doing so can cause damage to the projector.
3. Projecting an Image (Basic Operation)

8 After Use

Preparation: Make sure that the projector is turned off.

1. Unplug the power cable.

2. Disconnect any other cables.

3. Retract adjustable tilt foot if extended.

4. Cover the lens with the lens cap.

5. Put the projector and accessories in the supplied soft case.
   Place the projector in the soft case with the lens facing upward as shown below. This is to prevent the lens from damage.

! CAUTION:
Use caution when putting the projector in the soft case immediately after the projector has been operating. The projector cabinet is hot.
4. Convenient Features

1 Turning off the Image and Sound
Press the PIC-MUTE button to turn off the image and sound for a short period of time. Press again to restore the image and sound.

NOTE:
Sound from the AUDIO OUT jack (Stereo mini) can be turned off.

2 Freezing a Picture
Press the FREEZE button to freeze a picture. Press again to resume motion.

3 Enlarging a Picture
You can enlarge the picture up to four times.

NOTE: The maximum magnification may be less than four times depending on the signal.

To do so:

1. Press the MAGNIFY (+) button to magnify the picture.
   To move the magnified image, use the SELECT ▲,▼,◄ or ► button.

2. Press the MAGNIFY (-) button to return the image to the original size.
4 Changing Lamp Mode

This feature enables you to select two brightness modes of the lamp: Normal and Eco modes. The lamp life can be extended by using the Eco mode.

<table>
<thead>
<tr>
<th>Lamp Mode</th>
<th>Description</th>
<th>Status of LAMP indicator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal Mode</td>
<td>This is the default setting (100% Brightness).</td>
<td>Off</td>
</tr>
<tr>
<td>Eco Mode</td>
<td>Select this mode to increase the lamp life (approx. 80% Brightness).</td>
<td>Steady Green light</td>
</tr>
</tbody>
</table>

To change to the [Eco] mode, do the following:
1. Press the LAMP MODE button on the remote control to display [Lamp Mode] screen.
2. Use the SELECT ▲ or ▼ button to select [Eco] mode.
3. Press the ENTER button.
   To change from [Eco] to [Normal], Go back to Step 2 and select [Normal]. Repeat Step 3.

NOTE:
- The Lamp Mode can be changed by using the menu. Select [Setup] → [General] → [Lamp Mode].
- The lamp life remaining and lamp hours used can be checked in [Usage Time]. Select [Information] → [Usage Time].
- If the projector is overheated in Normal mode, there may be a case where the Lamp mode automatically changes to Eco mode to protect the projector. When the projector is in Eco mode, the picture brightness decreases. When the projector comes back to normal temperature, the Lamp mode returns to Normal mode.

Thermometer symbol [( ] indicates the lamp mode is automatically set to Eco mode because the internal temperature is too high.

5 Preventing the Unauthorized Use of the Projector

To enable the Security function:
1. Press the MENU button.
   The menu will be displayed.
2. Use the SELECT ▲ or ▼ button to select [Setup] and press the ENTER button.

3. Use the SELECT ▲ or ▼ button to select [Installation].
4. Use the SELECT ▲ or ▼ button to select [Security] and press the SELECT► button.
5. Use the SELECT ▲ or ▼ button to select [On] and press the ENTER button.

6. Type in a combination of the four SELECT buttons ▲▼◄► and press the ENTER button.

NOTE: A keyword must be 4 to 10 digits in length. Please make a note of your keyword.

The [Security Keyword] screen will be displayed.

7. Type in the same combination of SELECT button ▲▼◄► and press the ENTER button.

The confirmation screen will be displayed.

8. Select [Yes] and press the ENTER button.

The Security function has been enabled.
4. Convenient Features

To turn on the projector when Security is enabled:
1. **Press the Main Power Switch to the On position (I).**
2. **Press and hold the POWER ON or the ON/STAND BY button for a minimum of 1 second.**
   The projector will be turned on and display a message to the effect that the projector is security-protected.
3. **Press the MENU button.**

![](SecurityKeyword.png)

The Security Keyword screen will be displayed.
4. **Enter your keyword in the Security Keyword screen and press the ENTER button.**
You can view the projected image.

**NOTE:** The security disable mode is maintained until the main power is turned off (by setting the main power switch to "O" or unplugging the power cord).

**To disable the Security function:**
1. **Press the MENU button.**
The menu will be displayed.
2. **Use the SELECT ▲ or ▼ button to select [Setup] and press the ENTER button.**
3. **Use the SELECT ◀ or ► button to select [Installation].**
4. **Use the SELECT ▲ or ▼ button to select [Security] and press the SELECT ► button.**
5. **Use the SELECT ▲ or ▼ button to select [Off] and press the ENTER button.**

![](General.png)
The keyword confirmation screen will be displayed.
6. **Type in your keyword and press the ENTER button.**
When the correct keyword is entered, the Security function will be disabled.

**NOTE:**
- If you forget your keyword, contact your dealer. Your dealer will provide you with your keyword in exchange for your request code. Your request code is displayed in the Keyword Confirmation screen. In this example [NB52–YGK8–2VD6–K585–JNE6–EYA8] is a request code.
- The [Security] setting cannot be cancelled by using the [Reset] of the menu.
Using the Optional Remote Mouse Receiver (NP01MR)
The optional remote mouse receiver enables you to operate your computer’s mouse functions from the remote control. It is a great convenience for clicking through your computer-generated presentations.

Connecting the remote mouse receiver to your computer
If you wish to use the remote mouse function, connect the mouse receiver and computer. The mouse receiver can be connected directly to the computer’s USB port (type A).

NOTE: Depending on the type of connection or OS installed on your computer, you may have to restart your computer or change your computer settings.

When operating a computer via the remote mouse receiver

When connecting using the USB terminal
For PC, the mouse receiver can only be used with a Windows 98/Me/XP*, Windows 2000, Windows Vista, or Mac OS X 10.0.0 or later operating system.

* NOTE: In SP1 or older version of Windows XP, if the mouse cursor will not move correctly, do the following: Clear the Enhance pointer precision check box underneath the mouse speed slider in the Mouse Properties dialog box [Pointer Options tab].

NOTE: Wait at least 5 seconds after disconnecting the mouse receiver before reconnecting it and vice versa. The computer may not identify the mouse receiver if it is repeatedly connected and disconnected in rapid intervals.
4. Convenient Features

Operating your computer's mouse from the remote control

You can operate your computer’s mouse from the remote control.

- PAGE UP/DOWN Button: scrolls the viewing area of the window or to move to the previous or next slide in PowerPoint on your computer.
- SELECT ▲▼ ◄► Buttons: moves the mouse cursor on your computer.
- MOUSE L-CLICK Button: works as the mouse left button.
- MOUSE R-CLICK Button: works as the mouse right button.

About Drag Mode:

By pressing the MOUSE L-CLICK or R-CLICK button for 2 or 3 seconds then releasing, the drag mode is set and the drag operation can be performed simply by pressing the SELECT ▲▼ ◄► button. To drop the item, press the MOUSE L-CLICK (or R-CLICK) button. To cancel it, press the MOUSE R-CLICK (or L-CLICK) button.

 NOTE: When you operate the computer using the SELECT ▲▼ ◄► button with the menu displayed, both the menu and the mouse pointer will be affected. Close the menu and perform the mouse operation.

 TIP: You can change the Pointer speed on the Mouse Properties dialog box on the Windows. For more information, see the user documentation or online help supplied with your computer.
5. Using On-Screen Menu

1. **Using the Menus**

   NOTE: The on-screen menu may not be displayed correctly while interlaced motion video image is projected.

1. Press the **MENU** button on the remote control or projector cabinet to display the Menu.

   ![Menu Button](image1.png)

2. Press the **SELECT ▲** or **▼** button on the remote control or the projector cabinet to highlight the menu for the item you want to adjust or set.

   ![Select Button](image2.png)

3. Press the **SELECT ►** button or the **ENTER** button on the remote control or the projector cabinet to select a submenu or item.

   ![Enter Button](image3.png)
4. Use the SELECT ▲ or ▼ button on the remote control or the projector cabinet to select the item you want to adjust or set.

5. Adjusting the level of a selected item or selecting an item.

For Adjusting items (Slide bar)
Slide bar ........ Indicates settings or the direction of adjustment.
• Use the SELECT ▶ buttons to adjust the item.

For Selecting items (Solid triangle)
Solid triangle .... Indicates further choices are available. A highlighted triangle indicates the item is active.
(1) Use the SELECT ▶ button to select the item.
(2) Use the SELECT ▲▼ buttons to highlight the item you want to set.
(3) Press the ENTER button. The selected item will be displayed.

For Selecting items (Radio button)
Radio button .... Use this round button to select an option in a dialog box.
• Use the SELECT ▲▼ buttons to select the item.
Changes are stored until you adjust it again.
Press the EXIT button to return to the previous screen.

6. Repeat steps 2-5 to adjust an additional item, or press the MENU button to close the menu.
Menu windows or dialog boxes typically have the following elements:

- **Title** .................................. Indicates the menu title.
- **Highlight** .............................. Indicates the selected menu or item.
- **Source** ................................. Indicates the currently selected source.
- **Off Timer remaining time** ........ Indicates the remaining countdown time when the Off Timer is preset.
- **Solid triangle** ......................... Indicates further choices are available. A highlighted triangle indicates the item is active.
- **Tab** ................................... Indicates a group of features in a dialog box. Selecting on any tab brings its page to the front.
- **Radio button** ......................... Use this round button to select an option in a dialog box.
- **Check mark** ............................ Indicates the item is selected.
- **Slide bar** ............................... Indicates settings or the direction of adjustment.
- **Key Lock symbol** .................... Indicates the Control Panel Lock is enabled.
- **Thermometer symbol** .............. Indicates the lamp mode is forcibly set to Eco mode because the internal temperature is too high.
- **High Altitude symbol** ............ Indicates the [Fan Mode] is set to [High Altitude] mode.
### 5. Using On-Screen Menu

#### 3 List of Menu Items

Some menu items are not available depending on the input source.

<table>
<thead>
<tr>
<th>Picture</th>
<th>Default</th>
<th>Item</th>
<th>Resettable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preset</td>
<td>*</td>
<td>1 to 6</td>
<td>Yes</td>
</tr>
<tr>
<td>Detail Settings</td>
<td>General</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reference</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gamma Correction</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color Temperature</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>White Balance</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pressed Item</th>
<th>Default</th>
<th>Item</th>
<th>Resettable</th>
</tr>
</thead>
</table>

- Some menu items are not available depending on the input source.

<table>
<thead>
<tr>
<th>Image Options</th>
<th>Default</th>
<th>Item</th>
<th>Resettable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aspect Ratio</td>
<td>*</td>
<td>Normal, Wide, Cinema, Native</td>
<td>Yes</td>
</tr>
<tr>
<td>Cinema Position</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Horizontal</td>
<td>*</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Vertical</td>
<td>*</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Clock</td>
<td>*</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Phase</td>
<td>*</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Video Filter</td>
<td>*</td>
<td>Off, Less, More</td>
<td>Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Setup</th>
<th>Default</th>
<th>Item</th>
<th>Resettable</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Auto Keystone</td>
<td>Off</td>
<td>Off, On</td>
</tr>
<tr>
<td>Keystone</td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Keystone Save</td>
<td>Off</td>
<td>Off, On</td>
<td>Yes</td>
</tr>
<tr>
<td>Wall Color</td>
<td>Off</td>
<td>Off, Blackboard, Blackboard(Gray), Light yellow, Light green, Light blue, Sky blue, Light rose, Pink</td>
<td>Yes</td>
</tr>
<tr>
<td>Lamp Mode</td>
<td>Normal</td>
<td>Normal, Eco</td>
<td>Yes</td>
</tr>
<tr>
<td>Language</td>
<td>English</td>
<td>English, Deutsch, Français, Italiano, Español, Português, Nederlands, Svenska, Norsk, Suomi, Čeština, Magyar, Polski, Türkçe, 日本語, 中文, 한국어, 드미, Dansk</td>
<td>–</td>
</tr>
<tr>
<td>Beep</td>
<td>On</td>
<td>Off, On</td>
<td>Yes</td>
</tr>
<tr>
<td>Installation</td>
<td>Orientation</td>
<td>Desktop Front</td>
<td>Desktop Front, Ceiling Rear, Desktop Rear, Ceiling Front</td>
</tr>
<tr>
<td>Communication Speed</td>
<td>19200</td>
<td>4800, 9600, 19200</td>
<td>–</td>
</tr>
<tr>
<td>Control Panel Lock</td>
<td>Off</td>
<td>Off, On</td>
<td>Yes</td>
</tr>
<tr>
<td>Security</td>
<td>Off</td>
<td>Off, On</td>
<td>–</td>
</tr>
<tr>
<td>Menu Color Select</td>
<td>Color</td>
<td>Color, Monochrome</td>
<td>Yes</td>
</tr>
<tr>
<td>Menu Display Time</td>
<td>Auto 45 sec</td>
<td>Manual, Auto 5 sec, Auto 15 sec, Auto 45 sec</td>
<td>Yes</td>
</tr>
<tr>
<td>Background</td>
<td>Blue</td>
<td>Blue, Black, Logo</td>
<td>Yes</td>
</tr>
<tr>
<td>Filter Message</td>
<td>500[H]</td>
<td>Off, 100[H], 200[H], 500[H], 1000[H]</td>
<td>–</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Options</th>
<th>Default</th>
<th>Item</th>
<th>Resettable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off Timer</td>
<td>Off</td>
<td>Off, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00</td>
<td>Yes</td>
</tr>
<tr>
<td>Auto Adjust</td>
<td>Normal</td>
<td>Off, Normal, Fine</td>
<td>Yes</td>
</tr>
<tr>
<td>Auto Start</td>
<td>Off</td>
<td>Off, On</td>
<td>Yes</td>
</tr>
<tr>
<td>Power Management</td>
<td>Off</td>
<td>Off, 0:05, 0:10, 0:20, 0:30</td>
<td>Yes</td>
</tr>
<tr>
<td>Fan Mode</td>
<td>Auto</td>
<td>Auto, High, High Altitude</td>
<td>–</td>
</tr>
<tr>
<td>Default Source Select</td>
<td>Last</td>
<td>Last, Auto, Computer 1, Computer 2 (Digital), Computer 2 (Analog), Video, S-Video</td>
<td>Yes</td>
</tr>
</tbody>
</table>

* The asterisk (*) indicates that the default setting varies depending on the signal.
## 5. Using On-Screen Menu

<table>
<thead>
<tr>
<th>Item</th>
<th>Usage Time</th>
<th>Source</th>
<th>Signal Select</th>
<th>Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Computer 1</td>
<td>Current Signal</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>RGB/Component</td>
<td>All Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Component</td>
<td>Clear Lamp Hours</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Clear Filter Hours</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Computer 2 (Analog)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>RGB/Component</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Component</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Video</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Auto</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>S-Video</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Auto</td>
<td></td>
</tr>
<tr>
<td>Deinterlace</td>
<td>Off, On</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Information Item</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Usage Time</td>
<td>Lamp Life Remaining</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lamp Hours Used</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Filter Hours Used</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Source</td>
<td>Source index</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Horizontal Frequency</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vertical Frequency</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Signal Type</td>
<td></td>
<td>RGB, Component, Video, S-Video, HDTV, Digital</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Video Type</td>
<td></td>
<td>NTSC, NTSC3.58, NTSC4.43, PAL, PAL-M, PAL-N, PAL60, SECAM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sync Type</td>
<td></td>
<td>Separate Sync, Composite Sync, Sync on Green, Sync on Video</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sync Polarity</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Scan Type</td>
<td></td>
<td>Interlace, Non-interlace</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td>Product</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Serial Number</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Firmware</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Data</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Menu Descriptions & Functions [Picture]

Preset

When selecting user adjustable [Preset], the submenu will be displayed. You can customize each gamma or color. To do so, first select [Preset] and press the ENTER button, then proceed using the following steps.

Detail Settings

Selecting Reference Setting [Reference]
This option allows you to adjust neutral tint for yellow, cyan or magenta. There are six factory presets optimized for various types of images, you can set user adjustable settings.

- High-Bright .......... Recommended for the use in a brightly lit room.
- Presentation .......... Recommended for making a presentation using a PowerPoint file.
- Video .................. Recommended for standard video such as a TV program.
- Movie .................. Recommended for film based video such as a movie (DVD or HDTV).
- Graphic............... Recommended for viewing accurate colors in graphics.
- sRGB .................. Standard color values.

Selecting Gamma Correction Mode [Gamma Correction]
Each mode is recommended for:

- Dynamic ............... Creates a high-contrast picture.
- Natural ................ Natural reproduction of the picture.
- Black Detail ............ Emphasizes detail in dark areas of the picture.

Adjusting Color Temperature [Color Temperature]
This option allows you to select the color temperature of your choice.

NOTE: When [High-Bright] or [Presentation] is selected in [Reference], [Color Temperature] is not available.
5. Using On-Screen Menu

Adjusting White Balance [White Balance]
This allows you to adjust the white balance. Contrast for each color (RGB) to adjust the white level of the screen; Brightness for each color (RGB) is used to adjust the black level of the screen.

Adjusting Contrast, Brightness, Sharpness, Color and Hue
You can adjust contrast, brightness, sharpness, color and hue.

Contrast ....................... Adjusts the intensity of the image according to the incoming signal (White level of the image).
Brightness ....................... Adjusts the brightness level or the black level of the image.
Sharpness ....................... Controls the detail of the image for Video (not valid for RGB).
Color ............................. Increases or decreases the color saturation level (not valid for RGB).
Hue .............................. Varies the color level from +/- green to +/- blue. The red level is used as reference. This adjustment is only valid for Video and Component inputs (not valid for RGB).

Reset
The settings and adjustments for [Picture] will be returned to the factory settings with the exception of the following; Preset numbers and [Reference] within the [Preset] screen.
The settings and adjustments under [Detail Settings] within the [Preset] screen that are not currently selected will not be reset.

5 Menu Descriptions & Functions [Image Options]

Selecting Aspect Ratio [Aspect Ratio]
Aspect Ratio allows you to select the best Aspect mode to display your source image.
You can also display the Aspect Ratio menu by pressing the ASPECT button on the remote control.

When 4:3 is selected from the source (i.e. DVD player), the following selections will display:

<table>
<thead>
<tr>
<th>Normal</th>
<th>Wide Zoom</th>
<th>Cinema</th>
<th>Native</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="4:3 Aspect Standard" /></td>
<td><img src="image" alt="Left and right stretched" /></td>
<td><img src="image" alt="Left and right stretched" /></td>
<td><img src="image" alt="Native" /></td>
</tr>
</tbody>
</table>

When 16:9 is selected from the source (i.e. DVD player), the following selections will display:

<table>
<thead>
<tr>
<th>Normal</th>
<th>Wide Zoom</th>
<th>Cinema</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="16:9 image displayed in 4:3 mode" /></td>
<td><img src="image" alt="Left and right stretched" /></td>
<td><img src="image" alt="Left and right stretched to display the true aspect" /></td>
</tr>
</tbody>
</table>

Native (RGB only): Turns off the scaling feature. The projector displays the current image in its true resolution.
NOTE:
• When you are displaying an RGB image with a higher resolution than the projector's native resolution, the image will be displayed in the projector's native resolution. In this case [Native] is not available from the menu. Only when displaying an RGB image with a lower resolution than the projector’s native resolution, will the image be able to be displayed in its true resolution [Native].
• When Computer 2 (Digital) is selected, some options of Aspect Ratio are not available depending on the signal.
• You can adjust the image position for Cinema aspect. See [Cinema Position] for setting the image position.

Copyright
Please note that using this projector for the purpose of commercial gain or the attraction of public attention in a venue such as a coffee shop or hotel and employing compression or expansion of the screen image with a [Aspect Ratio] setting may raise concern about the infringement of copyrights which are protected by copyright law.

Adjusting the Vertical Position of Image [Cinema Position] (for Cinema only)
This feature adjusts the vertical position of the image when viewing video with Cinema aspect ratio selected. When [Cinema] is selected in [Aspect Ratio], the image is displayed with black borders on the top and bottom. You can adjust the vertical position from the top to the bottom of the black area.

NOTE: This option is available only when [Cinema] is selected in [Aspect Ratio].

Adjusting Horizontal/Vertical Position, Clock and Phase [Horizontal/Vertical/Clock/Phase] (available for RGB signal only)
You can adjust the image manually for position and stability; [Horizontal], [Vertical], [Clock] and [Phase].

[Horizontal/Vertical]
Adjusts the image location horizontally and vertically.

[Clock]
Use this item to fine tune the computer image or to remove any vertical banding that might appear. This function adjusts the clock frequencies that eliminate the horizontal banding in the image. This adjustment may be necessary when you connect your computer for the first time.

[Phase]
Use this item to adjust the clock phase or to reduce video noise, dot interference or cross talk. (This is evident when part of your image appears to be shimmering.) Use [Phase] only after the [Clock] is complete.

NOTE:
A projected image may not be displayed correctly during adjustment of [Clock] or [Phase]. This is normal.

NOTE: The [Horizontal] and [Vertical] options can be adjusted for component signals.

Selecting Video Filter Level [Video Filter] (not available for Digital RGB, Video and S-Video)
Select one of the three levels for reducing video noise: Off, Less or More.

Off ......................... The low-pass filter is turned off.
Less .......................... The low-pass filter is applied partially.
More ......................... The low-pass filter is applied fully.

NOTE:
• Selecting [Off] will give best image quality by way of higher bandwidth. Selecting [Less] will soften the image and selecting [More] will soften the image more.
5. Using On-Screen Menu

6 Menu Descriptions & Functions [Setup]

[General]

![On-Screen Menu Configuration](image)

- **Auto Keystone**
  - This feature allows the projector to detect its tilt and correct vertical distortion automatically. To turn on the Auto Keystone feature, select [On].

- **Correcting Vertical Keystone Distortion Manually**
  - You can correct vertical distortion manually.

- **Saving Vertical Keystone Correction**
  - This option enables you to save your current keystone settings.
    - Off ......................... Does not save current keystone correction settings
    - On ......................... Saves current keystone correction settings
  - Saving your change once affects all sources. The changes are saved when the projector is off.

  **NOTE:** When [Auto Keystone] is set to [On], [Keystone Save] is not available. Next time you turn on the power, the Auto Keystone function will work and the data stored with [Keystone Save] will be invalid.

- **Selecting Wall Color Correction Mode**
  - This function allows for quick adaptive color correction in applications where the screen material is not white. The following nine options are available: Off, Blackboard, Blackboard (Gray), Light yellow, Light green, Light blue, Sky blue, Light rose and Pink.

- **Selecting Lamp Mode**
  - This feature enables you to select two brightness modes of the lamp: Normal and Eco modes. The lamp life can be extended by using the Eco mode.
    - Normal Mode .......... This is the Default setting (100% Brightness).
    - Eco Mode .............. Select this mode to increase the lamp life (approx. 80% Brightness).

- **Selecting Menu Language**
  - You can choose one of 21 languages for the on-screen menu.

- **Enabling Key Sound and Error Sound**
  - This feature turns on or off the keypad sound or alarm when a button on the cabinet and the remote control is pressed or an error occurs.
5. Using On-Screen Menu

[Installation]

<table>
<thead>
<tr>
<th>Picture</th>
<th>General</th>
<th>Installation</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Options</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Setup</td>
<td>Orientation</td>
<td>✓ Desktop Front</td>
<td></td>
</tr>
<tr>
<td>Information</td>
<td>Communication Speed</td>
<td>✓ 19200bps</td>
<td></td>
</tr>
<tr>
<td>Reset</td>
<td>Control Panel Lock</td>
<td>✓ Off</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Security</td>
<td>✓ Off</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Menu Color Select</td>
<td>✓ Color</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Menu Display Time</td>
<td>✓ Auto 45 sec</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Background</td>
<td>✓ Blue</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Filter Message</td>
<td>✓ 500[H]</td>
<td></td>
</tr>
</tbody>
</table>

Computer 1

Selecting Projector Orientation [Orientation]
This sets your image for your type of projection application. The options are:
desktop front projection, ceiling rear projection, desktop rear projection, and ceiling front projection.

Selecting Communication Speed [Communication Speed]
This feature sets the baud rate of the PC CTRL port (Mini DIN 8 Pin). It supports data rates from 4800 to 19200 bps. The default is 19200 bps.
Select the appropriate baud rate for your equipment to be connected (depending on the equipment, a lower baud rate may be recommended for long cable runs).
Your selected communication speed will not be affected even when [Reset] is done from the menu.

Disabling the Cabinet Buttons [Control Panel Lock]
This option turns on or off the Key Lock function for cabinet buttons.

NOTE:
• The Control Panel Lock setting will not affect the remote control or PC Control Functions.
• When the cabinet buttons are disabled, pressing and holding the EXIT button on the projector cabinet for about 10 seconds will change the setting to enable.
• The Key Lock icon will be displayed at the bottom right of the menu when Control Panel Lock is enabled.
Enabling Security [Security]
This feature turns on or off the Security function.
Unless the correct keyword is entered, the projector cannot project an image. (→page 29)

Selecting Menu Color [Menu Color Select]
You can choose between two color modes for menu color: color and monochrome.

Selecting Menu Display Time [Menu Display Time]
This option allows you to select how long the projector waits after the last touch of a button to turn off the menu.
The preset choices are [Manual], [Auto 5 sec], [Auto 15 sec], and [Auto 45 sec].

Selecting a Color for Background [Background]
Use this feature to display a blue, black or logo when no signal is available.

Selecting Interval Time for Filter Message [Filter Message]
This option allows you to select the time preference between displaying the message for cleaning the filters. Clean the filter when you get the message "Please clean filter." (→page 48)
Five options are available: Off, 100[H], 200[H], 500[H], 1000[H]
The default setting is 500[H].

NOTE: Your setting will not be affected even when [Reset] is done from the menu.

[Options]

<table>
<thead>
<tr>
<th>Picture</th>
<th>General</th>
<th>Installation</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Options</td>
<td>Off Timer</td>
<td>Auto Adjust</td>
<td>Auto Start</td>
</tr>
<tr>
<td>Setup</td>
<td>✓ Off</td>
<td>✓ Normal</td>
<td>✓ Off</td>
</tr>
<tr>
<td>Information</td>
<td>Power Management</td>
<td>Fan Mode</td>
<td>Default Source Select</td>
</tr>
<tr>
<td>Reset</td>
<td>✓ Off</td>
<td>✓ Auto</td>
<td>✓ Last</td>
</tr>
<tr>
<td></td>
<td>Signal Select</td>
<td>Deinterlace</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>On</td>
</tr>
</tbody>
</table>

Setting Off Timer [Off Timer]
You can use the Off Timer feature to turn off the projector automatically at a preset time.
Eight preset times can be selected: Off, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00 and 16:00.

Setting Auto Adjust [Auto Adjust]
This feature sets the Auto Adjust mode so that the RGB image can be automatically or manually adjusted for noise and stability. You can automatically make adjustment in two ways: Normal and Fine

Off ......................... The RGB image will not be automatically adjusted.
You can manually optimize the RGB image.
Normal ................ Default setting. The RGB image will be automatically adjusted. Normally select this option.
Fine ....................... Select this option if fine adjustment is needed. It takes more time to switch to the source than when [Normal] is selected.

Enabling Auto Start [Auto Start]
Turns the projector on automatically when the power cable is inserted into an active power outlet. This eliminates the need to always use the POWER button on the remote control or projector cabinet.
To use the Auto Start function, you must first press the main power switch to the position “On” (I) before plugging the power cable.
Enabling Power Management [Power Management]
When this option is selected you can enable the projector to automatically turn off (at the selected time: 5 min., 10 min., 20 min., 30 min.) if there is no signal received by any input.

Enabling Fan Speed Mode [Fan Mode]
This option allows you to select three modes for fan speed: Auto mode, High speed mode, and High Altitude mode.

- **Auto** ...................... The built-in fans automatically run at a variable speed according to the internal temperature.
- **High** ...................... The built-in fans run at a fixed high speed.
- **High Altitude** ........ The built-in fans run at a high speed. Select this option when using the projector at altitudes approximately 5500 feet/1600 meters or higher.

When you wish to cool down the temperature inside the projector quickly, select [High].

**NOTE:**
- It is recommended that you select High speed mode if you use the projector non-stop for consecutive days.
- Using the projector at altitudes approximately 5500 feet/1600 meters or higher without setting to [High Altitude] can cause the projector to overheat and the protector could shut down. If this happens, wait a couple minutes and turn on the projector.
- Using the projector at altitudes less than approximately 5500 feet/1600 meters and setting to [High Altitude] can cause the lamp to overcool, causing the image to flicker. Switch [Fan Mode] to [Auto].
- Your setting will not be affected even when [Reset] is done from the menu.

Selecting Default Source [Default Source Select]
You can set the projector to default to any one of its inputs each time the projector is turned on.

- **Last** ...................... Sets the projector to default to the previous or last active input each time the projector is turned on.
- **Auto** ...................... Searches for an active source in order of Computer 1 → Computer 2 (Digital) → Computer 2 (Analog) → Video → S-Video → Computer 1 and displays the first found source.
- **Computer 1** ........... Displays the RGB source from the COMPUTER 1 IN connector every time the projector is started up.
- **Computer 2 (Digital)** Displays the DVI digital source from the COMPUTER 2 IN connector every time the projector is started up.
- **Computer 2 (Analog)** Displays the RGB source from the COMPUTER 2 IN connector every time the projector is started up.
- **Video** ..................... Displays the Video source from the VIDEO IN connector every time the projector is started up.
- **S-Video** ................. Displays the Video source from the S-VIDEO IN connector every time the projector is started up.

Selecting Signal Format [Signal Select]
[Computer 1],[Computer 2 (Analog)]
Allows you to choose [Computer 1], or [Computer 2 (Analog)] for an RGB source such as a computer, or [Component] for a component video source such as a DVD player. Normally select [RGB/Component] and the projector automatically detects a component signal. However there may be some component signals that the projector is unable to detect. If this is the case, select [Component].

[Video & S-Video System Select]
This feature enables you to select composite video standards automatically or manually. Normally select [Auto] and the projector will automatically detect the video standard. In the case where the projector has difficulty detecting the video standard, select the appropriate video standard from the menu. This must be done for Video and S-Video respectively.

Enabling the deinterlace [Deinterlace]
Turns on or off the deinterlace function for a telecine signal.

- **On** ...................... Default standard setting.
- **Off** ...................... Select this option if there is any jitter or artifacts in video.

**NOTE:** This feature is not available for RGB, 480p, 576p and HDTV signals.
5. Using On-Screen Menu

Menu Descriptions & Functions [Information]
Displays the status of the current signal and lamp usage. This item has three pages. The information included is as follows:

[Usage Time]

- **Lamp Life Remaining** (%)*1
- **Lamp Hours Used** (H)*2
- **Filter Hours Used** (H)*2

*1: The progress indicator shows the percentage of remaining bulb life. The value informs you of the amount of lamp usage. When the remaining lamp time reaches 0, the Remaining Lamp Time bar indicator changes from 0% to 100 Hours and starts counting down. If the remaining lamp time reaches 0 hours, the projector will not turn on regardless of whether the lamp mode is set to Normal or Eco.

*2: The message for lamp replacement and filter cleaning will be displayed under the following conditions:
- for one minute after the projector has been powered on.
- when the POWER ON/STAND BY button on the projector cabinet or the POWER OFF button on the remote control is pressed.

To cancel the message, press any button on the projector cabinet or the remote control.

<table>
<thead>
<tr>
<th>Lamp life(H)</th>
<th>Replacement lamp</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal (min.)</td>
<td>Eco (max.)</td>
</tr>
<tr>
<td>2000</td>
<td>3000</td>
</tr>
</tbody>
</table>

[Source]

- **Source Index**
- **Horizontal Frequency** 48[kHz]
- **Vertical Frequency** 60[Hz]
- **Signal Type** RGB
- **Video Type** ----
- **Sync Type** Separate Sync
- **Sync Polarity** H:(~) V:(~)
- **Scan Type** Non-Interlace

[Source Index] [Horizontal Frequency] [Video Type] [Sync Polarity] [Scan Type]
5. Using On-Screen Menu

### Menu Descriptions & Functions [Reset]

**Returning to Factory Default [Reset]**

The Factory Default feature allows you to change adjustments and settings to the factory preset for a (all) source(s) except the following:

- **[Current Signal]**
  - Resets the adjustments for the current signal to the factory preset levels.
  - The items that can be reset are: [Preset], [Contrast], [Brightness], [Color], [Hue], [Sharpness], [Aspect Ratio], [Horizontal], [Vertical], [Clock], [Phase] and [Video Filter].

- **[All Data]**
  - Resets all the adjustments and settings for all the signals to the factory preset.
  - All items can be reset except [Language], [Communication Speed], [Security], [Filter Message], [Fan Mode], [Lamp Life Remaining], [Lamp Hours Used] and [Filter Hours Used].
  - To reset the lamp usage time, see “Clearing Lamp Hour Meter [Clear Lamp Hours] below”.

**Clearing Lamp Hour Meter [Clear Lamp Hours]**

Resets the lamp clock back to zero. Selecting this option displays submenu for a confirmation. Select [Yes] and press the ENTER button.

*NOTE: Elapsed time of the lamp use will not be affected even when [Reset] is done from the menu.*

**Clearing the Filter Usage Hours [Clear Filter Hours]**

Resets the filter usage back to zero. Selecting this option displays submenu for a confirmation. Select [Yes] and press the ENTER button.

*NOTE: Elapsed time of the filter use will not be affected even when [Reset] is done from the menu.*
6. Maintenance

This section describes the simple maintenance procedures you should follow to clean the filters and replace the lamp.

1 Cleaning or Replacing the Filters

The air-filter sponge keeps dust and dirt from getting inside the projector and should be frequently cleaned. If the filter is dirty or clogged, your projector may overheat.

NOTE: The message for filter cleaning will be displayed for one minute after the projector is turned on or off. To cancel the message, press any button on the projector cabinet or the remote control.

CAUTION
- Turn off the projector, turn off the main power switch and unplug the projector before replacing the filters.
- Only clean the outside of the filter cover with a vacuum cleaner.
- Do not attempt to operate the projector without the filter cover.

To clean the air-filter:
Vacuum the filter through the filter cover.

To replace the filter (sponge):
1. Remove the filter cover by pushing down on the catch of the cover until you feel it detach.

2. Gently peel off the filter (sponge) and replace it with the new one.
3. Reinstall the new filter cover.

4. Clear the filter hours used.
To reset the filter usage time, from the menu, select [Reset] → [Clear Filter Hours].
(→ page 47 for resetting the filter usage time.)

NOTE: Do not wash the filter with soap and water. Soap and water will damage the filter membrane. Before replacing the filter, remove dust and dirt from the projector cabinet. Keep out dust and dirt during filter replacement.

NOTE: When you replace the lamp, it is also wise to replace the filter. The filter comes in the same package with your replacement lamp.

Cleaning the Cabinet and the Lens
1. Turn off the projector before cleaning.
2. Clean the cabinet periodically with a damp cloth. If heavily soiled, use a mild detergent. Never use strong detergents or solvents such as alcohol or thinner.
3. Use a blower or lens paper to clean the lens, and be careful not to scratch or mar the lens.
Replacing the Lamp

After your lamp has been operating for 2000 hours (up to 3000 hours in Eco mode) or longer, the LAMP indicator in the cabinet will blink red and the message [The lamp has reached the end of its usable life. Please replace the lamp.]* will appear. Even though the lamp may still be working, replace it at 2000 (up to 3000 hours in Eco mode) hours to maintain optimal projector performance. After replacing the lamp, be sure to clear the lamp hour meter. (→ page 47)

CAUTION

• DO NOT TOUCH THE LAMP immediately after it has been used. It will be extremely hot. Turn the projector off, wait 30 seconds, turn off the main power switch and then disconnect the power cable. Allow at least one hour for the lamp to cool before handling.

• DO NOT REMOVE ANY SCREWS except two lamp case screws. You could receive an electric shock.

• Do not break the glass on the lamp housing.

Keep finger prints off the glass surface on the lamp housing. Leaving finger prints on the glass surface might cause an unwanted shadow and poor picture quality.

• The projector will turn off and go into standby mode after 2100 (up to 3100 hours in Eco mode) hours of service. If this happens, be sure to replace the lamp. If you continue to use the lamp after 2000 hours (up to 3000 hours in Eco mode) of use, the lamp bulb may shatter, and pieces of glass may be scattered in the lamp case. Do not touch them as the pieces of glass may cause injury. If this happens, contact your NEC dealer for lamp replacement.

*NOTE: This message will be displayed under the following conditions:
  • for one minute after the projector has been powered on
  • when the POWER ON/STAND BY button on the projector cabinet or the POWER OFF button on the remote control is pressed

To turn off the message, press any button on the projector cabinet or the remote control.

To replace the lamp:
Optional lamp and tools needed for replacement:
  • Replacement lamp NP05LP

1. Place the projector on a soft cloth and turn it over to access the lamp cover on the bottom.
2. Remove the lamp cover.
   (1) Press firmly and slide the lamp cover by 1 cm (0.4")
   • Do not force to pull the lamp cover
   (2) Push to release two catches on both sides and slide the lamp cover off.

3. Remove the lamp housing.
   (1) Loosen the two screws securing the lamp housing until the phillips screwdriver goes into a freewheeling condition. The two screws are not removable.
   (2) Remove the lamp housing by holding it.

**NOTE:** There is an interlock on this case to prevent the risk of electrical shock. Do not attempt to circumvent this interlock.
6. Maintenance

4. **Install a new lamp housing.**
   (1) Insert a new lamp housing until the lamp housing is plugged into the socket.

   **CAUTION**
   Do not use a lamp other than the NEC replacement lamp NP05LP. Order this from your NEC dealer.

   (2) Secure it in place with the two screws. Be sure to tighten the screws.

5. **Reattach the lamp cover.**
   (1) Place the lamp cover, aligning it with the guiding line.
   (2) Slide the lamp cover back until it snaps into place.

6. **Connect the supplied power cable, turn on the Main Power switch and turn on the projector.**
7. **Finally, select the menu → [Reset] → [Clear Lamp Hours] to reset the lamp usage hours.**

   **NOTE:** When the lamp exceeds 2100 hours (up to 3100 hours in Eco mode) of service, the projector cannot turn on and the menu is not displayed. If this happens, press the HELP button on the remote control for ten seconds to reset the lamp clock back to zero. When the lamp time clock is reset to zero, the LAMP indicator goes out.
# 7. Appendix

## 1 Troubleshooting

This section helps you resolve problems you may encounter while setting up or using the projector.

### Indicator Messages

#### Power Indicator

<table>
<thead>
<tr>
<th>Indicator Condition</th>
<th>Projector Condition</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>The main power is off</td>
<td>–</td>
</tr>
<tr>
<td>Blinking light</td>
<td>Green, 0.5 sec On, 0.5 sec Off</td>
<td>The projector is getting ready to turn on.</td>
</tr>
<tr>
<td></td>
<td>Orange, 2.5 sec On, 0.5 sec Off</td>
<td>Off Timer is enabled.</td>
</tr>
<tr>
<td>Steady light</td>
<td>Green, 0.5 sec On, 0.5 sec Off</td>
<td>The projector is cooling down.</td>
</tr>
</tbody>
</table>

#### Status Indicator

<table>
<thead>
<tr>
<th>Indicator Condition</th>
<th>Projector Condition</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Normal</td>
<td>–</td>
</tr>
<tr>
<td>Blinking light</td>
<td>Red, 1 cycle (0.5 sec On, 2.5 sec Off)</td>
<td>Lamp cover error or lamp housing error</td>
</tr>
<tr>
<td></td>
<td>Red, 2 cycle (0.5 sec On, 0.5 sec Off)</td>
<td>Temperature error</td>
</tr>
<tr>
<td></td>
<td>Red, 4 cycle (0.5 sec On, 0.5 sec Off)</td>
<td>Fan error</td>
</tr>
<tr>
<td></td>
<td>Red, 6 cycle (0.5 sec On, 0.5 sec Off)</td>
<td>Lamp error</td>
</tr>
<tr>
<td>Green</td>
<td>Re-firing the lamp (The projector is cooling down.)</td>
<td>The projector is re-firing.</td>
</tr>
<tr>
<td>Steady light</td>
<td>Orange</td>
<td>Cabinet button is locked</td>
</tr>
</tbody>
</table>

#### Lamp Indicator

<table>
<thead>
<tr>
<th>Indicator Condition</th>
<th>Projector Condition</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Normal</td>
<td>–</td>
</tr>
<tr>
<td>Blinking light</td>
<td>Red</td>
<td>Lamp has reached its end of life. Lamp replacement message will be displayed.</td>
</tr>
<tr>
<td>Steady light</td>
<td>Red</td>
<td>Lamp has been used beyond its limit. The projector will not turn on until the lamp is replaced.</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Lamp mode is set to Eco mode</td>
</tr>
</tbody>
</table>

### Over-Temperature Protection

If the temperature inside the projector rises too high, the over-temperature protector will automatically turn off the lamp with the STATUS indicator blinking (2-cycle On and Off.)

Should this happen, do the following:
- Unplug the power cable after the cooling fans stop.
- Move the projector to a cooler location if the room where you are presenting is particularly too warm.
- Clean the ventilation holes if they are clogged with dust.
- Wait about 60 minutes until the inside of the projector becomes cool enough.
### Common Problems & Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Check These Items</th>
</tr>
</thead>
</table>
| Does not turn on or shut down | • Check that the power cable is plugged in and that the power button on the projector cabinet or the remote control is on. (→ pages 17 and 18)  
• Ensure that the lamp cover is installed correctly. (→ page 52)  
• Check to see if the projector has overheated. If there is insufficient ventilation around the projector or if the room where you are presenting is particularly warm, move the projector to a cooler location.  
• Check to see if the lamp usage exceeds 2100 hours (up to 3100 hours: Eco mode). If so, replace the lamp. After replacing the lamp, reset the lamp hours used. (→ page 47)  
• The lamp may fail to light. Wait a full minute and then turn on the power again.  
• Set [Fan Mode] to [High Altitude] when using the projector at altitudes approximately 5500 feet/1600 meters or higher. Using the projector at altitudes approximately 5500 feet/1600 meters or higher without setting to [High Altitude] can cause the projector to overheat and the projector could shut down. If this happens, wait a couple minutes and turn on the projector. (→ page 45)  
Also when the lamp is turned off, the projector internal temperature is hot. If the power is turned on before the projector has cooled down, the fan will run a short time before the lamp will turn on. |
| Will turn off | • Ensure that the Power Management or Off Timer is off. (→ page 44) |
| No picture | • Use the COMPUTER1, the COMPUTER2, the VIDEO or the S-VIDEO button on the remote control to select your source (Computer, Video or S-Video). (→ page 20) If there is still no picture, press the button again.  
• Ensure your cables are connected properly.  
• Use menus to adjust the brightness and contrast. (→ page 40)  
• Remove the lens cap.  
• Reset the settings or adjustments to factory preset levels using the [Reset] in the Menu. (→ page 47)  
• Enter your registered keyword if the Security function is enabled. (→ page 29)  
• Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on the power to the notebook PC. In most cases the output signal from the notebook PC is not turned on unless connected to the projector before being powered up.  
* If the screen goes blank while using your remote control, it may be the result of the computer’s screen-saver or power management software.  
• See also the next page. |
| Picture suddenly becomes dark | • When one of the following happens, the Lamp mode automatically changes from Normal to Eco.  
  * When there are no signals → To return to the Normal mode, select another available source.  
  * When the room where you’re presenting is particularly warm → Move the projector to a cooler location, or set [Fan Mode] to [High]. (→ page 45)  
• Check if an appropriate color is selected in [Wall Color]. If so, select an appropriate option. (→ page 42)  
• Adjust [Hue] in [Picture]. (→ page 40) |
| Color tone or hue is unusual | • Reposition the projector to improve its angle to the screen. (→ page 21)  
• Use the Keystone correction function to correct the trapezoid distortion. (→ page 23)  
• Adjust the focus. (→ page 22)  
• Reposition the projector to improve its angle to the screen. (→ page 21)  
• Ensure that the distance between the projector and screen is within the adjustment range of the lens. (→ page 10)  
• Condensation may form on the lens if the projector is cold, brought into a warm place and is then turned on. Should this happen, let the projector stand until there is no condensation on the lens. |
| Image isn’t square to the screen | • Set [Fan Mode] to other than [High Altitude] mode when using the projector at altitudes approximately 5500 feet/1600 meters or lower. Using the projector at altitudes less than approximately 5500 feet/1600 meters and setting to [High Altitude] can cause the lamp to overcool, causing the image to flicker. Switch [Fan Mode] to [Auto]. (→ page 45)  
• Use the COMPUTER1, the COMPUTER2, the VIDEO or the S-VIDEO button on the remote control to select your source (Computer, Video or S-Video). (→ page 20)  
• Adjust the computer image manually with the Horizontal/Vertical in the [Image Options]. (→ page 41) |
| Image is scrolling vertically, horizontally or both | • Install new batteries. (→ page 8)  
• Make sure there are no obstacles between you and the projector.  
• Stand within 22 feet (7 m) of the projector. (→ page 8) |
| Remote control does not work | • Press the AUTO ADJ. button on the projector cabinet or the remote control. (→ page 25)  
• Adjust the computer image manually with Clock/Phase in [Image Options] in the menu. (→ page 41)  
• See the POWER/STATUS/LAMP Indicator. (→ page 53) |

For more information contact your dealer.
If there is no picture, or the picture is not displayed correctly.

- Power on process for the projector and the PC.
  Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on the power to the notebook PC.
  In most cases the output signal from the notebook PC is not turned on unless connected to the projector before being powered up.

  **NOTE:** You can check the horizontal frequency of the current signal in the projector’s menu under Information. If it reads “0kHz”, this means there is no signal being output from the computer. (→ page 46 or go to next step)

- Enabling the computer’s external display.
  Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projector. When using a PC compatible laptop, a combination of function keys will enable/disable the external display. Usually, the combination of the ‘Fn” key along with one of the 12 function keys gets the external display to come on or off. For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through external display selections.

- Non-standard signal output from the computer
  If the output signal from a notebook PC is not an industry standard, the projected image may not be displayed correctly. Should this happen, deactivate the notebook PC’s LCD screen when the projector display is in use. Each notebook PC has a different way of deactivate/reactivate the local LCD screens as described in the previous step. Refer to your computer’s documentation for detailed information.

- Image displayed is incorrect when using a Macintosh
  When using a Macintosh with the projector, set the DIPswitch of the Mac adapter (not supplied with the projector) according to your resolution. After setting, restart your Macintosh for the changes to take affect.
  For setting display modes other than those supported by your Macintosh and the projector, changing the DIP switch on a Mac adapter may bounce an image slightly or may display nothing. Should this happen, set the DIP switch to the 13” fixed mode and then restart your Macintosh. After that, restore the DIP switches to a displayable mode and then restart the Macintosh again.

  **NOTE:** A Video Adapter cable manufactured by Apple Computer is needed for a PowerBook which does not have a mini D-Sub 15-pin connector.

- Mirroring on a PowerBook
  * When using the projector with a Macintosh PowerBook, output may not be set to 1024 x 768 unless “mirroring” is off on your PowerBook. Refer to owner’s manual supplied with your Macintosh computer for mirroring.

- Folders or icons are hidden on the Macintosh screen
  Folders or icons may not be seen on the screen. Should this happen, select [View] → [Arrange] from the Apple menu and arrange icons.
## Specifications

This section provides technical information about the VT700 projector's performance.

### Model Number

**VT700**

### Optical

<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>LCD Panel</td>
<td>0.63&quot; p-Si TFT active-matrix with Micro Lens Array</td>
</tr>
<tr>
<td>Resolution</td>
<td>1024 × 768 pixels* native, up to UXGA with Advanced AccuBlend</td>
</tr>
<tr>
<td>Lens</td>
<td>Manual zoom and manual focus</td>
</tr>
<tr>
<td>Lens F1.7 - 2.0 f=18.9 - 22.7 mm</td>
<td></td>
</tr>
<tr>
<td>Lamp</td>
<td>210 W AC lamp (172W Eco mode)</td>
</tr>
<tr>
<td>Light Output**</td>
<td>3000 lumens (approx. 80% in Eco mode)</td>
</tr>
<tr>
<td>Contrast Ratio</td>
<td>500: 1 (full white: full black)</td>
</tr>
<tr>
<td>Image Size (Diagonal)</td>
<td>21 - 300 inches / 0.5 - 7.6 m</td>
</tr>
<tr>
<td>Projection Distance</td>
<td>28 - 424 inches / 0.7 - 10.7 m</td>
</tr>
<tr>
<td>Projection Angle</td>
<td>Tele: 8.3° - 8.6°/ Wide: 9.9° - 10.3°</td>
</tr>
<tr>
<td>Keystone Correction</td>
<td>+/- 30° Vertical</td>
</tr>
</tbody>
</table>

### Electrical

<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs</td>
<td>1 RGB/Component (D-Sub 15 Pin), 1 RGB (Digital/Analog) (DVI-I 29 Pin, HDCP*** supported), 1 S-Video (DIN 4 Pin), 1 Video (RCA), 1 (L/R) RCA Audio, 1 Stereo Mini Audio, 1 PC Control (DIN 8 Pin)</td>
</tr>
<tr>
<td>Outputs</td>
<td>1 RGB (D-Sub 15 Pin), 1 Stereo Mini Audio</td>
</tr>
<tr>
<td>Video Compatibility</td>
<td>NTSC, NTSC4.43, PAL, PAL60, PAL-N, PAL-M, SECAM, DTV: 480i, 480p, 720p, 1080i (60Hz), 576i, 576p, 1080i (50Hz), DVD: Progressive (50/60Hz)</td>
</tr>
<tr>
<td>Scan Rate</td>
<td>Horizontal: 15 kHz to 100 kHz (RGB: 24 kHz or over) Vertical: 50 Hz to 120 Hz</td>
</tr>
<tr>
<td>Video Bandwidth</td>
<td>RGB: 80 MHz (-3dB)</td>
</tr>
<tr>
<td>Color Reproduction</td>
<td>16.7 million colors simultaneously, Full color</td>
</tr>
<tr>
<td>Horizontal Resolution</td>
<td>NTSC / NTSC4.43/PAL/PAL-M/PAL-N/PAL60, SECAM: 300 TV lines SECAM: 300 TV lines</td>
</tr>
<tr>
<td></td>
<td>RGB: 1024 dots (H) × 768 dots (V),</td>
</tr>
<tr>
<td>External Control</td>
<td>RS232, IR</td>
</tr>
<tr>
<td>Sync Compatibility</td>
<td>Separate Sync / Composite Sync / Sync on Green / Sync on Video</td>
</tr>
<tr>
<td>Built-in Speaker</td>
<td>5W (monaural)</td>
</tr>
<tr>
<td>Power Requirement</td>
<td><strong>VT700</strong>: 100 - 240V AC, 50 / 60 Hz</td>
</tr>
<tr>
<td></td>
<td><strong>VT700G</strong>: 200 - 240V AC, 50 / 60 Hz</td>
</tr>
<tr>
<td>Input Current</td>
<td><strong>VT700</strong>: 3.3 - 1.5 A</td>
</tr>
<tr>
<td></td>
<td><strong>VT700G</strong>: 1.7 A</td>
</tr>
<tr>
<td>Power Consumption</td>
<td>8W in Standby mode / 295W in Lamp Normal mode / 240W in Lamp Eco mode</td>
</tr>
</tbody>
</table>
**Mechanical**

**Installation Orientation**
- Desktop/Front, Desktop/Rear, Ceiling/Front, Ceiling/Rear

**Dimensions**
- 12.2” (W) × 4.4” (H) × 10.2” (D)
- 309mm (W) × 112mm (H) × 258mm (D)
- (not including protrusions)

**Weight**
- 6.8 lbs / 3.1 kg

**Environmental Considerations**
- **Operational Temperatures**: 41° to 104°F (5° to 40°C),
  (Eco mode selected automatically at 95°F to 104°F/35°C to 40°C)
- 20% to 80% humidity (non-condensing)
- **Storage Temperatures**: 14° to 122°F (-10° to 50°C),
  20% to 80% humidity (non-condensing)

* Effective pixels are more than 99.99%.
** This is the light output value (lumens) when the [Preset] mode is set to [High-Bright]. If any other mode is selected as the [Preset] mode, the light output value may drop slightly.
*** What is HDCP/HDCP technology?

HDCP is an acronym for High-bandwidth Digital Content Protection. High bandwidth Digital Content Protection (HDCP) is a system for preventing illegal copying of video data sent over a Digital Visual Interface (DVI).

If you are unable to view material via the DVI input, this does not necessarily mean the projector is not functioning properly. With the implementation of HDCP, there may be cases in which certain content is protected with HDCP and might not be displayed due to the decision/intention of the HDCP community (Digital Content Protection, LLC).

**Regulations**

**For United States:**
- UL Approved (UL 60950-1)
- Meets FCC Class B requirements

**For Canada:**
- UL Approved (CSA 60950-1)
- Meets DOC Canada Class B requirements

**For Australia/New Zealand:**
- Meets AS/NZS CISPR.22 Class B

**For Europe:**
- Meets EMC Directive (EN55022, EN55024, EN61000-3-2, EN61000-3-3)
- Meets Low Voltage Directive (EN60950-1, TÜV GS Approved)

For additional information visit:

For information on our optional accessories, visit our website or see our brochure.

The specifications are subject to change without notice.
3 Cabinet Dimensions

Unit: mm (inch)
Pin Assignments of D-Sub COMPUTER Input Connector

Mini D-Sub 15 Pin Connector

Signal Level
Video signal: 0.7Vp-p (Analog)
Sync signal: TTL level

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>RGB Signal (Analog)</th>
<th>YCbCr Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Red</td>
<td>Cr</td>
</tr>
<tr>
<td>2</td>
<td>Green or Sync on Green</td>
<td>Y</td>
</tr>
<tr>
<td>3</td>
<td>Blue</td>
<td>Cb</td>
</tr>
<tr>
<td>4</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Red Ground</td>
<td>Cr Ground</td>
</tr>
<tr>
<td>7</td>
<td>Green Ground</td>
<td>Y Ground</td>
</tr>
<tr>
<td>8</td>
<td>Blue Ground</td>
<td>Cb Ground</td>
</tr>
<tr>
<td>9</td>
<td>No Connection</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Sync Signal Ground</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>No Connection</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Bi-directional DATA (SDA)*</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Horizontal Sync or Composite Sync</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Vertical Sync</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Data Clock*</td>
<td></td>
</tr>
</tbody>
</table>

* Only COMPUTER 1 input connector supported.
## 5 Compatible Input Signal List

Horizontal: 15KHz to 100KHz (RGB: 24KHz or over)  
Vertical: 50Hz to 120Hz

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution ( Dots )</th>
<th>Frequency H. ( kHz )</th>
<th>Refresh Rate ( Hz )</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>–</td>
<td>15.73</td>
<td>59.94</td>
</tr>
<tr>
<td>PAL</td>
<td>–</td>
<td>15.63</td>
<td>50.00</td>
</tr>
<tr>
<td>PAL60</td>
<td>–</td>
<td>15.73</td>
<td>60.00</td>
</tr>
<tr>
<td>SECAM</td>
<td>–</td>
<td>15.63</td>
<td>50.00</td>
</tr>
<tr>
<td>D VESA</td>
<td>640 × 480</td>
<td>31.47</td>
<td>59.94</td>
</tr>
<tr>
<td>D IBM</td>
<td>640 × 480</td>
<td>31.48</td>
<td>59.95</td>
</tr>
<tr>
<td>D MAC</td>
<td>640 × 480</td>
<td>35.00</td>
<td>66.67</td>
</tr>
<tr>
<td>D VESA</td>
<td>640 × 480</td>
<td>37.86</td>
<td>72.81</td>
</tr>
<tr>
<td>D VESA</td>
<td>640 × 480</td>
<td>37.50</td>
<td>75.00</td>
</tr>
<tr>
<td>D IBM</td>
<td>640 × 480</td>
<td>39.38</td>
<td>75.00</td>
</tr>
<tr>
<td>D IBM</td>
<td>720 × 350</td>
<td>31.47</td>
<td>70.08</td>
</tr>
<tr>
<td>D IBM</td>
<td>720 × 400</td>
<td>39.44</td>
<td>87.85</td>
</tr>
<tr>
<td>D VESA</td>
<td>800 × 600</td>
<td>35.16</td>
<td>56.25</td>
</tr>
<tr>
<td>D VESA</td>
<td>800 × 600</td>
<td>37.88</td>
<td>60.32</td>
</tr>
<tr>
<td>D VESA</td>
<td>800 × 600</td>
<td>48.08</td>
<td>72.19</td>
</tr>
<tr>
<td>D VESA</td>
<td>800 × 600</td>
<td>46.88</td>
<td>75.00</td>
</tr>
<tr>
<td>D VESA</td>
<td>832 × 624</td>
<td>49.72</td>
<td>74.55</td>
</tr>
<tr>
<td>D VESA</td>
<td>1024 × 768</td>
<td>48.36</td>
<td>60.00</td>
</tr>
<tr>
<td>D VESA</td>
<td>1024 × 768</td>
<td>56.48</td>
<td>70.07</td>
</tr>
<tr>
<td>D VESA</td>
<td>1024 × 768</td>
<td>60.24</td>
<td>74.93</td>
</tr>
<tr>
<td>D VESA</td>
<td>1024 × 768</td>
<td>60.02</td>
<td>75.03</td>
</tr>
<tr>
<td>D VESA</td>
<td>1024 × 768</td>
<td>68.68</td>
<td>85.00</td>
</tr>
<tr>
<td>D VESA</td>
<td>1152 × 864</td>
<td>67.50</td>
<td>75.00</td>
</tr>
<tr>
<td>D MAC</td>
<td>1152 × 870</td>
<td>68.68</td>
<td>75.06</td>
</tr>
<tr>
<td>D VESA</td>
<td>1280 × 960</td>
<td>60.00</td>
<td>60.00</td>
</tr>
<tr>
<td>#</td>
<td>1280 × 960</td>
<td>75.00</td>
<td>75.00</td>
</tr>
<tr>
<td>#</td>
<td>1280 × 960</td>
<td>85.94</td>
<td>85.00</td>
</tr>
<tr>
<td>D #</td>
<td>1280 × 1024</td>
<td>63.98</td>
<td>60.02</td>
</tr>
<tr>
<td>D #</td>
<td>1280 × 1024</td>
<td>64.30</td>
<td>60.38</td>
</tr>
<tr>
<td># MAC</td>
<td>1280 × 1024</td>
<td>69.87</td>
<td>65.18</td>
</tr>
<tr>
<td># VESA</td>
<td>1280 × 1024</td>
<td>79.98</td>
<td>75.02</td>
</tr>
<tr>
<td># VESA</td>
<td>1280 × 1024</td>
<td>91.15</td>
<td>85.02</td>
</tr>
<tr>
<td># VESA</td>
<td>1400 × 1050</td>
<td>63.98</td>
<td>60.02</td>
</tr>
<tr>
<td># VESA</td>
<td>1600 × 1200</td>
<td>75.00</td>
<td>60.00</td>
</tr>
<tr>
<td># VESA</td>
<td>1600 × 1200</td>
<td>81.25</td>
<td>65.00</td>
</tr>
<tr>
<td># VESA</td>
<td>1600 × 1200</td>
<td>87.50</td>
<td>70.00</td>
</tr>
<tr>
<td># VESA</td>
<td>1600 × 1200</td>
<td>93.75</td>
<td>75.00</td>
</tr>
<tr>
<td>SDTV(576i)</td>
<td>–</td>
<td>15.63</td>
<td>50.00 Interlace</td>
</tr>
<tr>
<td>D SDTV(576p)</td>
<td>–</td>
<td>31.25</td>
<td>50.00 Progressive</td>
</tr>
<tr>
<td>D # HDTV (1080i)</td>
<td>1920 × 1080</td>
<td>33.75</td>
<td>60.00 Interlace</td>
</tr>
<tr>
<td>D # HDTV (1080p)</td>
<td>1920 × 1080</td>
<td>28.13</td>
<td>50.00 Interlace</td>
</tr>
<tr>
<td>D # HDTV (720p)</td>
<td>1280 × 720</td>
<td>45.00</td>
<td>60.00 Progressive</td>
</tr>
<tr>
<td>D SDTV (480i)</td>
<td>720 × 480</td>
<td>31.47</td>
<td>59.94 Progressive</td>
</tr>
<tr>
<td>DVD YCbCr</td>
<td>–</td>
<td>15.73</td>
<td>59.94 Interlaced</td>
</tr>
<tr>
<td>DVD YCrC</td>
<td>–</td>
<td>15.63</td>
<td>50.00 Interlaced</td>
</tr>
</tbody>
</table>

# : Images in above flagged with # are compressed with Advanced AccuBlend on VT700.  
D : Images in above flagged with “D” are supported by the DVI digital signals on VT700.

**NOTE:** Some composite sync signals may not be displayed correctly.  
Signals other than those specified in the table above may not be displayed correctly. If this should happen, change the refresh rate or resolution on your PC. Refer to Display Properties help section of your PC for procedures.  
UXGA (1600 × 1200) is supported for separate sync signal only.
PC Control Codes and Cable Connection

PC Control Codes

<table>
<thead>
<tr>
<th>Function</th>
<th>Code Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>POWER ON</td>
<td>02H 00H 00H 00H 00H 02H</td>
</tr>
<tr>
<td>POWER OFF</td>
<td>02H 01H 00H 00H 00H 03H</td>
</tr>
<tr>
<td>INPUT SELECT COMPUTER 1</td>
<td>02H 03H 00H 00H 02H 01H 01H 09H</td>
</tr>
<tr>
<td>INPUT SELECT COMPUTER 2 (Digital)</td>
<td>02H 03H 00H 00H 02H 01H 1AH 22H</td>
</tr>
<tr>
<td>INPUT SELECT COMPUTER 2 (Analog)</td>
<td>02H 03H 00H 00H 02H 01H 02H 0AH</td>
</tr>
<tr>
<td>INPUT SELECT S-VIDEO</td>
<td>02H 03H 00H 00H 02H 01H 06H 0EH</td>
</tr>
<tr>
<td>PICTURE MUTE ON</td>
<td>02H 10H 00H 00H 00H 12H</td>
</tr>
<tr>
<td>PICTURE MUTE OFF</td>
<td>02H 11H 00H 00H 00H 13H</td>
</tr>
<tr>
<td>SOUND MUTE ON</td>
<td>02H 12H 00H 00H 00H 14H</td>
</tr>
<tr>
<td>SOUND MUTE OFF</td>
<td>02H 13H 00H 00H 00H 15H</td>
</tr>
</tbody>
</table>

NOTE: Contact your local dealer for a full list of the PC Control Codes if needed.

Cable Connection

Communication Protocol

- Baud rate: 19200 bps
- Data length: 8 bits
- Parity: No parity
- Stop bit: One bit
- X on/off: None
- Communications procedure: Full duplex

NOTE: Depending on the equipment, a lower baud rate may be recommended for long cable runs.

PC Control Connector (DIN-8P)

NOTE: Pins 2, 3, 5, 6 and 8 are used inside the projector.
## Troubleshooting Check List

Before contacting your dealer or service personnel, check the following list to be sure repairs are needed also by referring to the “Troubleshooting” section in your user’s manual. This checklist below will help us solve your problem more efficiently.

* Print this page and the next page for your check.

### Frequency of occurrence
- □ always
- □ sometimes (How often? ____________)
- □ other (___________)

### Power

- □ No power (POWER indicator does not light green) See also “Status Indicator (STATUS)”.
- □ Power cable’s plug is fully inserted into the wall outlet.
- □ Main power switch is pressed to the ON position.
- □ Lamp cover is installed correctly.
- □ Lamp Hours Used (lamp operation hours) was cleared after lamp replacement.
- □ No power even though you press and hold the POWER button for 1 second.
- □ Shut down during operation.
- □ Power cable’s plug is fully inserted into the wall outlet.
- □ Lamp cover is installed correctly.
- □ Power Management is turned off (only models with the Power Management function).
- □ Off Timer is turned off (only models with the Off Timer function).

### Video and Audio

- □ No image is displayed from your PC or video equipment to the projector.
- □ Still no image even though you connect the projector to the PC first, then start the PC.
- □ Enabling your notebook PC’s signal output to the projector.
- □ A combination of function keys will enable/disable the external display. Usually, the combination of the “Fn” key along with one of the 12 function keys turns the external display on or off.
- □ No image (blue or black background, no display).
- □ Still no image even though you press the AUTO ADJUST button.
- □ Still no image even though you carry out [Reset] in the projector’s menu.
- □ Signal cable’s plug is fully inserted into the input connector.
- □ A message appears on the screen.
- □ The source connected to the projector is active and available.
- □ Still no image even though you adjust the brightness and/or the contrast.
- □ Input source’s resolution and frequency are supported by the projector.
- □ Image is too dark.
- □ Remains unchanged even though you adjust the brightness and/or the contrast.
- □ Image is distorted.
- □ Image appears to be trapezoidal (unchanged even though you carry out the [Keystone] adjustment).
- □ Parts of the image are lost.
- □ Still unchanged even though you press the AUTO ADJUST button.
- □ Still unchanged even though you carry out [Reset] in the projector’s menu.
- □ Image is shifted in the vertical or horizontal direction.
- □ Horizontal and vertical positions are correctly adjusted on a computer signal.
- □ Input source’s resolution and frequency are supported by the projector.
- □ Some pixels are lost.
- □ Image is flickering.
- □ Still unchanged even though you press the AUTO ADJUST button.
- □ Still unchanged even though you carry out [Reset] in the projector’s menu.
- □ Image shows flickering or color drift on a computer signal.
- □ Still unchanged even though you change [Fan Mode] from [High Altitude] to [Auto].
- □ Image appears blurry or out of focus.
- □ Still unchanged even though you checked the signal’s resolution on PC and changed it to projector’s native resolution.
- □ Still unchanged even though you adjusted the focus.
- □ No sound.
- □ Audio cable is correctly connected to the audio input of the projector.
- □ Still unchanged even though you adjusted the volume level.
- □ AUDIO OUT is connected to your audio equipment (only models with the AUDIO OUT connector).

### Other

- □ Remote control does not work.
- □ No obstacles between the sensor of the projector and the remote control.
- □ Projector is placed near a fluorescent light that can disturb the infrared remote controls.
- □ Batteries are new and are not reversed in installation.
- □ Buttons on the projector cabinet do not work (only models with the Key Lock function).
- □ Control Panel Lock is not turned on or is disabled in the menu.
- □ Still unchanged even though you press and hold the EXIT button for a minimum of 10 seconds.
In the space below please describe your problem in detail.

Information on application and environment where your projector is used

<table>
<thead>
<tr>
<th>Projector</th>
<th>Installation environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model number:</td>
<td>Screen size: inch</td>
</tr>
<tr>
<td>Serial No.:</td>
<td>Screen type: White matte, Beads, Polarization, Wide angle, High contrast</td>
</tr>
<tr>
<td>Date of purchase:</td>
<td>Throw distance: feet/inch/m</td>
</tr>
<tr>
<td>Lamp operating time (hours):</td>
<td>Orientation: Ceiling mount, Desktop</td>
</tr>
<tr>
<td>Lamp Mode: Normal, Eco</td>
<td>Power outlet connection:</td>
</tr>
<tr>
<td></td>
<td>Connected directly to wall outlet</td>
</tr>
<tr>
<td>Information on input signal:</td>
<td>Connected to power cord extender or other (the number of connected equipment)</td>
</tr>
<tr>
<td>Horizontal synch frequency [ ] kHz</td>
<td>Connected to a power cord reel or other (the number of connected equipment)</td>
</tr>
<tr>
<td>Vertical synch frequency [ ] Hz</td>
<td></td>
</tr>
<tr>
<td>Synch polarity H (+), (–) V (+), (–)</td>
<td></td>
</tr>
<tr>
<td>Synch type Separate, Composite Sync on Green</td>
<td></td>
</tr>
<tr>
<td>STATUS Indicator: Steady light Orange, Green Flashing light [ ] cycles</td>
<td></td>
</tr>
<tr>
<td>Remote control model number:</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signal cable</th>
</tr>
</thead>
<tbody>
<tr>
<td>NEC standard or other manufacturer's cable?</td>
</tr>
<tr>
<td>Model number: Length: inch/m</td>
</tr>
<tr>
<td>Distribution amplifier</td>
</tr>
<tr>
<td>Model number:</td>
</tr>
<tr>
<td>Switcher</td>
</tr>
<tr>
<td>Model number:</td>
</tr>
<tr>
<td>Adapter</td>
</tr>
<tr>
<td>Model number:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manufacturer:</td>
</tr>
<tr>
<td>Model number:</td>
</tr>
<tr>
<td>Notebook PC Desktop</td>
</tr>
<tr>
<td>Native resolution:</td>
</tr>
<tr>
<td>Refresh rate:</td>
</tr>
<tr>
<td>Video adapter:</td>
</tr>
<tr>
<td>Other:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Video equipment</th>
</tr>
</thead>
<tbody>
<tr>
<td>VCR, DVD player, Video camera, Video game or other</td>
</tr>
<tr>
<td>Manufacturer:</td>
</tr>
<tr>
<td>Model number:</td>
</tr>
</tbody>
</table>
8 TravelCare Guide

TravelCare - a service for international travelers

This product is eligible for "TravelCare", NEC's unique international warranty. Please note that TravelCare coverage differs in part from coverage under the warranty included with the product.

Services offered with TravelCare

This warranty allows customers to receive service on their product at the NEC and NEC-designated service stations in the countries listed herein when temporarily traveling internationally for business or pleasure.

For details on services offered by the different service stations, please refer to the "List of TravelCare Outlets" below.

1 Repair services

The product will be repaired and delivered within 10 business days, not including shipping time.

During the term of warranty, the cost of maintenance parts, labor costs for repairs and shipping costs within the service station’s coverage area are covered by the warranty.

2 Replacement product rental service

If the customer desires, he or she can rent a replacement product while the original product is being repaired.

Fee: US$200 for 12 days

This fee must be paid at the local service station in cash or credit card. The US$200 rental fee is non-refundable even if the customer rents it less than 12 days before returning.

The replacement product will be delivered within 3 business days. If the customer did not return the replacement product within 12 days, the customer will be charged the price of the unit.

If the customer returned the replacement product in a faulty or damaged condition, the repair cost will be charged to the customer. Note that this service is not offered in all countries and regions. Please refer to the "List of TravelCare Outlets". In addition, this replacement product rental service is not offered after the product’s warranty has expired.

Term of warranty

1. Upon presentation of the warranty or receipt received upon purchase:

   Valid for the term indicated on the warranty or the normal term of warranty for the country of purchase.

2. When the product is brought in:

   Valid for a period of within 14 months of the date of manufacture indicated by the serial number attached to the product.

2 When a product whose term of warranty is expired is brought in:

   Repairs will be offered for a fee. In this case the customer is not eligible for the replacement product rental service.

3 In the following cases, repairs may be charged, even if the product’s warranty is still in effect:

   1) If the term of warranty, model name, serial number and name of the store of purchase are not indicated on the warranty or have been altered.

   2) Problems or damage caused by dropping or shocks during shipment or movement by the customer or by improper handling by the customers.

   3) Problems or damage caused by improper usage or unwarrantable alterations or repairs by the customer.

   4) Problems or damage caused by fire, salt damage, gas damage, earthquakes, lightning damage, storm or flood damage or other natural disasters or such external factors as dust, cigarette smoke, abnormal voltage, etc.

   5) Problems or damage caused by use in hot or humid places, in vehicles, boats or ships, etc.

   6) Problems or damage caused by expendable supplies or devices connected to the product other than those designated by NEC.

   7) Problems caused by natural consumption, wear or deterioration of parts under normal usage conditions.

   8) Problems or damage to lamps and other expendable supplies, included parts or optional parts.

   9) Other conditions stipulated in the warranty included with the product also apply.

NOTE: The product can be used overseas with voltages indicated in the rating label on the product by using a power cable suited for the standards and power source voltage of the country in which the product is being used.

List of TravelCare Outlets

This list applies as of April 1, 2007.

For the most up-to-date information, please refer to the websites of the service stations in the various countries on the List of TravelCare Outlets or to the NEC website at http://www.nec-pj.com.

In Europe

NEC Europe Ltd. / European Technical Centre

Address: Unit G, Stafford Park 12, Telford TF3 3BJ, U.K.
Telephone: +44 1952 237000
Fax Line: +44 1952 237006
Email Address: AFR@uk.neceur.com
WEB Address: http://www.neceur.com

(Regions Covered)

EEA: Norway*, Iceland and Liechtenstein


In North America

NEC Display Solutions of America, Inc.

Address: 500 Park Boulevard, Suite 1100 Itasca, Illinois 60143, U.S.A.
Telephone: +1 800 836 0655
Fax Line: +1 800 356 2415
Email Address: vsd.tech-support@necsam.com
WEB Address: http://www.necdisplay.com/

(Regions Covered)

U.S.A. *, Canada*

In Oceania

NEC Australia Pty., Ltd.

Address:

New South Wales;

184 Milperra Road, Reversby NSW 2212
Telephone: +61 2 9780 8688 Fax Line: +61 2 9780 8659
Victoria;

Unit 1/6 Garden Road, Clayton VIC 3168
Telephone: +61 3 8562 6245 Fax Line: +61 3 8562 6220
Newcastle;

120 Parry Street Newcastle West NSW 2300
Telephone: +61 2 4926 2466
Queensland;

Unit 4/305 Montague Road West End QLD 4101
Telephone: +61 7 3840 5840 Fax Line: +61 7 3840 5866
Goldcoast QLD;

Shop1 48 Ferry Road Southport QLD 4215
Telephone: +61 7 5591 3670
South Australia;

84A Richmond Road, Keswick 5035
Telephone: +61 8 8375 5707 Fax Line: +61 8 8375 5757
Western Australia;

45 Sarich Court Osborne Park WA 6017
Telephone: +61 8 9445 5901 Fax Line: +61 8 9445 5999
Hyosung ITX Co., Ltd.
Address: 2nd Fl., Ire B/D. #2, 4Ga, Yangpyeong-Dong, Youngdeungpo-Gu, Seoul, Korea 150-967
Telephone: +82 2 2163 4193
Fax Line: +82 2 2163 4196
Email Address: moneybear@hyosung.com

(Regions Covered)
South Korea

LENKO Communication Co., Ltd.
Address: 292 Lenso House 4, 1st Floor, Srinakarin Road, Huamark, Bangkapi, Bangkok 10240, Thailand
Telephone: +66 2 375 2425
Fax Line: +66 2 375 2434
Email Address: pattara@lenso.com
WEB Address: http://www.lenso.com

(Regions Covered)
Thailand

ABBA Electronics L.L.C.
Address: Tariq Bin Ziyad Road, P.O.Box 327, Dubai, United Arab Emirates
Telephone: +971 4 371800
Fax Line: +971 4 364283
Email Address: ABBA@emirates.net.ae

(Regions Covered)
United Arab Emirates

Samir Photographic Supplies
Address: P.O.Box 599, Jeddah 21421, Saudi Arabia
Telephone: +966 2 6828219
Fax Line: +966 2 6830820
Email Address: asif@samir-photo.com

Riyadh
Address: P.O.Box 5519, Riyadh 11432, Saudi Arabia
Telephone: +966 1 4645064
Fax Line: +966 1 4657912
Email Address: bhimji@samir-photo.com

Alkhobar
Address: P.O.Box 238, Alkhobar 31952, Saudi Arabia
Telephone: +966 3 8942674
Fax Line: +966 3 8948162
Email Address: chamsedin@samir-photo.com

(Regions Covered)
Saudi Arabia

NOTE: In countries designated with an asterisk (*), replacement product rental service are offered.
TO: NEC or NEC’s Authorized Service Station:
FM:

(Company & Name with signature)

Dear Sir (s),
I would like to apply your TravelCare Service Program based on attached registration and qualification sheet and agree with your following conditions, and also the Service fee will be charged to my credit card account, if I don’t return the Loan units within the specified period. I also confirm following information is correct. Regards.

Application Sheet for TravelCare Service Program

<table>
<thead>
<tr>
<th>Country, product purchased:</th>
</tr>
</thead>
<tbody>
<tr>
<td>User’s Company Name:</td>
</tr>
<tr>
<td>User’s Company Address:</td>
</tr>
<tr>
<td>Phone No., Fax No.:</td>
</tr>
<tr>
<td>User’s Name:</td>
</tr>
<tr>
<td>User’s Address:</td>
</tr>
<tr>
<td>Phone No., Fax No.:</td>
</tr>
<tr>
<td>Local Contact office:</td>
</tr>
<tr>
<td>Local Contact office Address:</td>
</tr>
<tr>
<td>Phone No., Fax No.:</td>
</tr>
<tr>
<td>User’s Model Name:</td>
</tr>
<tr>
<td>Date of Purchase:</td>
</tr>
<tr>
<td>Serial No. on cabinet:</td>
</tr>
<tr>
<td>Problem of units per User:</td>
</tr>
<tr>
<td>Required Service:</td>
</tr>
<tr>
<td>Requested period of Loan unit:</td>
</tr>
<tr>
<td>Payment method:</td>
</tr>
<tr>
<td>In Case of Credit Card:</td>
</tr>
<tr>
<td>Card No. w/Valid Date:</td>
</tr>
</tbody>
</table>
7. Appendix

Condition of your TravelCare Service Program

Enduser is requested to understand following condition of TravelCare Service Program and complete the necessary information on the application sheet.

1. Service Options:
There are 3 types of [Service] available. Enduser has to understand following condition and is required to fill in the Application Sheet.

1) Repair and Return:
The 'Faulty unit' is sent or collected from the customer. It is repaired and returned within 10 days to the customer, excluding transport time.

There may have a case, repair and return can't be done by NEC Authorized Service Station, because of shortage of spare parts due to same model is not sold in the territory.

2) Repair and Return with Loan: (This service is limited to some Service Stations)
This service is offered to the Enduser, who cannot wait until their unit is repaired.

The customer can borrow a unit for US$200 up to 12 days. Customer then sends in inoperable unit to nearest NEC Authorized Service Station for service. In order to prevent collection problem, Enduser is required to fill in Application Sheet.

Enduser needs to confirm the availability of the Service to NEC Authorized Service Stations.

3) Loan Only:
For this service, NEC Authorized Service Station supplies the customer with a loan unit for US$200 up to 12 days. Customer keeps the inoperable unit and when customer returns home, customer arranges to have the projector serviced in the home country.

2. Warranty Exclusions:
This program does not apply if the Projector's serial number has been defaced, modified or removed.

If, in the judgement of NEC Authorized Service Station or its agent the defects or failures result from any cause other than fair wear and tear or NEC neglect, or fault including the following without limitation:

1) Accidents, transportation, neglect, misuse, abuse, water, dust, smoke or default of or by the Customer its employees or agents or any third party;
2) Failure or fluctuation of electrical power, electrical circuitry, air conditioning, humidity control or other environmental conditions such as use it in smoking area;
3) Any fault in the attachments or associated products or components (whether or not supplied by NEC or its agents which do not form part of the Product covered by this warranty);
4) Any act of God, fire, flood, war, act of violence or any similar occurrence;
5) Any attempt by any person other than any person authorized by NEC to adjust, modify, repair, install or service the product.
6) Any Cross-border charges such as, duty, insurance, tax etc.

3. Charges for Warranty Exclusions and Out of Warranty Case:
In case faulty unit is under warranty exclusions case or under Out of Warranty period, NEC Authorized Service Station will Inform estimation of actual service cost to the Enduser with reason.

4. Dead on Arrival (DOA):
Enduser must take this issue up with their original supplier in the country of purchase.

NEC Authorized Service Station will repair the DOA unit as a Warranty repair, but will not exchange DOA unit with new units.

5. Loan Service Charges and Conditions:
Upon acceptance of this NEC Projector, Customer agrees to assume liability for this loan unit.

The current cost of use of this loan unit is US$200 for 12 calendar days. If Customer does not return the unit within the 12 calendar days, Customer will be charged the next highest cost up to and including the full list price to Credit Cards, which price will be informed by NEC Authorized Service Stations. Please see the attached listing of contacts for each country to arrange for pickup of the loan unit.

If you return to their country of origin with the loan unit, you will be charged additional freight to return the unit to the loaning country.

Thank you for your understanding of this program.